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GETTING STARTED

If you are unfamiliar with standard Macintosh
procedures and terminology such as turning
the computer on, starting up application pro-
grams, “double-clicking,” “dragging,” copying
files and disks, etc., it would be a good idea to
read the manuals that came with your
Macintosh before trying to run Sky Travel.

You can start up Sky Travel by either turning
on (or restarting) your Macintosh with the Sky
Travel disk in the drive, or by opening (double-
clicking) the Sky Travel ican from the Finder.

Note: Make a backup! Asaconvenience
to you, Sky Travel is not copy-
protected, and you are free to
make backup copies for your use
only.

Sky Travel is distributed on 400K format disks,
and needs about 60K of free space on the disk
forthe Print Chart command to work.
Because of this, there is little room left over for
desk accessories, fonts (which aren’t needed
by Sky Travel anyway), or the Finder.™ Quitting
Sky Travel will take you to the MiniFinder. If

you have disk drives that can read 800K format
disks, you may wish to create an 800K Sky
Travel work disk. To do this, format and pre-
pare an 800K disk, and make sure it has a recent
version of the System Folder on it. Copy the
Sky Travel icon and all other icons whose
names begin with “STData” into it. If there is
not enough room on the disk you are trying to
copy to, try using the Font/DA Mover utility
that came with your Macintosh to remove
unnecessary fonts and desk accessories, and
use the Finder to remove any unnecessary files
from the System Folder. All that should be
necessary are the files “System,” “Finder,” and
the files pertaining to the printer you are using.

If you have a hard disk, you may want to install
Sky Travel on it. To do this, create a new folder
and copy the Sky Travel icon and all other icons
whose names begin with “STData” into it.

Note: In order for Sky Travel to function
properly, all files beginning with
“STData” must reside in the same
folder as the Sky Travel icon.

SKY TRAVEL QUICK REFERENCE

This section is a brief summary of the features
of Sky Travel. Subsequent chapters will
describe the operations of the various elements
in greater detail.

When Sky Travel starts up there will be a pause
as it computes the planetary positions for the
current time, as indicated by the Macintosh
internal clock. The cursor changes to indicate

which planets are being computed. The sky
display will then appear, and Sky Travel will
be ready.

The Primary Windows

Sky Travel has four Primary Windows: Sky,
Clock, Info, and Position.
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application-switching programs appear from the particular time and place you
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drag any other Macintosh windows. Sky Window. As you drag the Mark around
All may be returned to their you will notice that several of the values in the
starting point by double-clicking Position Window change along with the

any of their window frames. position of the Mark.




Note: The World Map Dialog (accessed
fromthe World Map...
command in the Options
menu) also contains a Mark that
functions almost exactly as the
Mark in the Sky Window.

The Clock Window displays and allows you to
set the current date and time. This is accom-
plished by clicking on the various values you
want to change, using the up/down arrow
control that appears to change them, then
clicking outside the window. Sky Travel then
computes the new display.

The Info Window displays various information
in english sentences, and also holds a control
which allows you to rotate and incline your
telescope (this is called “slewing”). When the
Information... command from the
Options menuisinvoked, the database
entry for the selected object also appears in
this window.

The Position Window displays various infor-
mation relating to where you are on Earth,
where you are looking, and what point in the
sky you are looking at. Latitude and
Longitude pinpoint the position of your
“observatory” on Earth. Time Zone deter-
mines how your local time is calculated.
Elevation and Azimuth are the inclina-
tion and rotation of your telescope (where
you are looking). Right Ascension and
Declination pinpoint the position on the
““celestial globe” your telescope is pointed at
(what you are looking at).

The Menu Bar

The Sky Travel menu bar contains seven
menus: Apple, File, Edit, Options,
View, Find and Clock. Below is a brief
description of what each menu command

does. More detailed descriptions of these
functions will appear later in the manual.

The Apple Menu

The Apple menu (the one that appears as
the Apple® logo) contains whatever desk
accessories you currently have installed in your
System file and the About Sky Travel...
command which displays Sky Travel’s credits,
copyright messages, and version number.

The File Menu

Save Chart to MacPaint™ File...
allows you to save a full-page chart to disk that
you can edit using many Macintosh graphics
programs.

Print Chart printsa full-page chart to
whatever printer your system is currently set
up for.

Quit causes Sky Travel to shut down and
return control to the Finder (or MiniFinder if
you are using 400K format disks).

The Edit Menu

The standard functions in this menu, Cut,
Copy, Paste, Clear, and Undo areonly
included for compatibility with the desk acces-
sories in the Apple menu. You will not be
able to select any of the options in this menu
when a desk accessory’s window is in front of
any of Sky Travel’s windows.

The Options Menu

The Options menuallows you to change
your location with the World Map, get infor-
mation on any object in the sky, center your
view on any point visible, and change many
parameters that control what you see in the
Sky Window and how you see it.

World Map ... lets you reposition your
observatory almost anywhere on Earth and
also set your current local time zone. One
position and time zone may be saved to disk as




your “home,” making it easy to return there
after roaming anywhere else on the globe.
Sky Travel always goes to your home position
when it starts up.

Information. .. tells you about the object
in the Sky Window that is nearest the Mark.
Center View on Mark repositions your
view so the point the Mark is at is centered.
This is a fast way to get around the sky.

Track Object keeps the last moving object
found using the Find menu (Sun, Moon,
etc.) centered in the view.

Track Sky Position keeps the last
position the Mark was pointed at centered in
the view.

Constellation Lines controls the display
of the lines of the principal constellations.
Constellation Names controls the
display of the three-letter abbreviations next
to the constellations.

Planet Symbols controls the display of
the symbols used to identify the planets, in
place of dots representing the brightness of
the planets.

Ecliptic Symbols controls the display of
the ecliptic, and the zodiacal symbols along
the ecliptic.

Deep Sky Objects controls the displays of
normally invisible objects such as galaxies and
nebulae.

Celestial Globe Lines controls the
display of celestial coordinate lines for right
ascension and declination.

Chart Orientation allowsyou to display
the sky viewed either as an observer would
view it through a telescope or in a standard
format for printed charts.

Horizon allows you to display the Earth

either as translucent or completely
transparent.

Fast Slewing makes it possible to slew the
view faster by temporarily not calculating the
positions of dim stars or the Celetial Globe.

The View Menu
72°-4.5° let you choose the “lens”
through which you observe the sky.

North, South, East, West, and
Opposite letyou turn to look a particular
direction without having to slew your view
there manually.

The Find Menu

The Find menu lets you instantly locate the
Moon, Sun, planets, Halley’s Comet, and the
constellations. Selecting Venus, for
example, causes Sky Travel to redraw the Sky
Window with Venus and the Mark directly in
the center.

The Clock Menu

Reverse Clock lets you watch events both
in forward and reverse.

Sync to Internal Clock causes Sky
Travel to keep it’s clock in sync with the
battery-operated clock built into the
Macintosh.

0x - 64x lets you run Sky Travel’s clock at a
variety of speeds to watch events in
“time-lapse.”

Display Greenwich Mean
Time/Local Time lets you display the
clock in your local time zone or Greenwich
Mean Time (time zone 0).

Display 24/12 Hour Clock allows you
to choose between the “civilian” and
“military” methods of telling time.

Clock +1 Week and Clock -1 Week
provide a shorthand method to watch celestial
events (such as planetary retrogression) in
“time-lapse” over a period of weeks.




A GUIDED TOUR
OF SKY TRAVEL

A great deal of flexibility has been built into
Sky Travel to make it both versatile and easy to
use. This section explains how to operate the
program and how to choose from among the
many options to get the best results for your
particular purpose.

If you’re a novice, don’t get discouraged by
the astronomical drawings and explanations.
All that’s required to operate the program is
following directions and using the mouse.

You may bypass the descriptions of the various
coordinate systems at a first reading and still
be well rewarded by the uses you’ll find for
Sky Travel.

If you’re an expert, you’ll appreciate the
convenience of having Sky Travel do
preliminary calculations for you.

Starting Up

When you first start up Sky Travel you will be
looking at the four Primary Windows. When
using the program, you will alternate between
the Primary Windows and the World Map
Dialog. The World Map Dialog is invoked by
selecting the World Map ... command
from the Options menu. During the course
of this guided tour you will use the World Map
Dialog to reset the location of your
“observatory” on Earth and then return to the
Primary Windows to adjust the date and time
of your observance in the Clock Window.
After setting the clock, Sky Travel will
recalculate the proper location of the objects
in the sky using the new data from the World
Map Dialog and the Clock Window.

Understanding the
Examples

Throughout the manual, the examples given

follow the same general pattern:

1. Set the location from the World Map
Dialog.

2. Set the date and time in the Clock Window.

3. Observe the Sky Window.

Look at the following example step by step:

Imagine you’re looking out the window early
in the morning on January 1, 1985, in
Washington, D.C. You’re looking straight
south and, with the help of the line diagrams
and names magically painted in the sky, you
immediately recognize the constellation Leo
(the Lion).

The first thing you must do is place your
location in Washington, D.C. Go to the World
Map Dialog by selecting World Map...
from the Options menu, and set your
location:

38°54'N Latitude
77°0’W Longitude
Time Zone 5

To do this, drag the Mark to the vicinity of
Washington, D.C. on the World Map,
observing the latitude and longitude settings
until they roughly match the settings above.
Now use fine-adjustment control near the
bottom-center of the map. Click the mouse
button on the four arrows to fine-tune your
location (up/north, down/south, right/east
and left/west). Once the location values are
correct, click on the OK button to return to
the Primary Windows. The Sky display will
now show the sky as seen from Washington,
D.C., but the date and time still need to be
changed.




When Sky Travel starts up it synchronizes it’s
clock to the Macintosh internal clock and sets
it running forward. This is fine if you want to
observe what’s happening in real-time, but for
this example we want to freeze the action. To
do this, select the 0x command from the
Clock menu.
Remember that it is “early morning,” so
change the date and time settings to the
following:
Tuedan 1,1985 AD

4:55.0 AM

To do this, click on the value you wish to
change in the Clock Window. Then click on
the up-arrow to move forward in time and the
down-arrow to move backward. For example,
if the date reads “Nov 12, 1987,” first click on
“Nov” then on the up-arrow until it becomes
“Jan” for January. Next, click on the twelve;
now click on the down-arrow until it reads ““1,
and so on. Make sure the time is AM. When
you are done setting values, click anywhere
outside the Clock Window. Sky Travel will
then update the display to show the sky as it
appeared from Washington, D.C., on January
first, 1985, at 4:55 in the morning.

Note: In the Clock Window, the only
indicators that cannot be directly
set are the day-of-week, AD/BC,
and AM/PM. You set these by
manipulating the other values in
the window. Before exiting the
set-clock function, always check
all your values. If, for example,
you have moved the time forward
from 11:55 PM to 12:05 AM, the
day field will have increased by
one. Also check to make sure that
you have not accidentally
changed the year from AD to BC.

”

Most examples in this manual will involve the
manipulation of your point-of-view so that
you may observe the objects described. The
above example states: “You are looking
straight south.” To accomplish this, select the
South command from the View menu.
The messages in the Info Window will read,
“Looking south, above horizon. No eclipse in
progress. The Sun is down.”

Note: “No eclipse in progress’” may
seem like a strange choice of
words, since 99.99% of the time
there is no eclipse of any kind
happening. This was chosen for
two reasons. First, “No eclipse in
progress’ is a placeholder
showing that this space is for
telling you about eclipses when
they do happen. Second, only
one word needs to be changed
when an eclipse occurs; “No”
changes to “Solar” or “Lunar.”

The above example also mentions “line
diagrams and names magically painted in the
sky.” These may or may not be shown
depending on the current settings in the
Options menu. When Sky Travel starts up,
these options are on by default (they have a
check-mark if they’re on), but if you have
changed them you will need to select the
proper commands from the Options menu
to turn them back on. Now you are looking
south at the early morning Washington, D.C.,
sky, but the constellation of Leo may or may
not be visible depending on two things:
elevation and viewing angle. Your view angle
of the sky may range from a wide angle of 72°
to a narrow angle of 4.5°. When searching
for a particular object, use the widest viewing
angle to place the maximum number of




objects in the Sky Window. You select your
viewing angle from the View menu. If Leo
still is not visible, try adjusting your elevation
by pressing on the up- and down-pointing

& File Edit

Now you can scan the sky for other objects.

Press and hold on the right-pointing arrow of

the Slewing Control in the Info Window until

the message reads “Looking west” then stop.

You can now see the constellation Gemini (the

Twins).

Note: The “right-pointing arrow” is the

left-most arrow on the Slewing
Control. Thisis because it was

Options View Find Clock

arrows on the Slewing Control in the Info
Window. The screen should now look
something like this:

Tue Jan 1, 1985 AD

4:55.0 AM

Looking south, above horizon.
No eclipse in progress.
The Sun is down.

Latitude
Longitude

Time Zone

+ 59° 3
-180° 0*
11h32m 4
+ 7°57°

Elevation
Azimuth

Right Ascension
Declination

designed to suggest the axes that
your “telescope” can turn on.
From now on the “right-pointing
arrow” will simply be called the
“right-arrow,” etc.
Again press on the right-arrow of the Slewing
Control until the message reads “Looking
north,” and then stop: you now set the Big
Dipper and the Little Dipper. Near the center




of the screen is Polaris, the polestar. Now
press on the down-arrow of the Slewing
Control to move your view down until you see
the horizon (a dark-gray band) come up. Stop

& File Cait

Sky Travel’s Earth is translucent, which means
that objects that have already set or that may
be about to rise can actually be seen through
the Earth. You can also see the Sun and the
Moon when they are just below the horizon.
Press on the down arrow of the Slewing
Control to move your view farther down.
When you can look no farther down, you will
simply turn in a counter-clockwise circle,

Options VUliew Find Clock

when the horizon is about a third of the way
up the screen. You can now see the open “W”
shape of Cassiopeia just above the horizon in
the early morning hours.
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Tue Jan 1, 1985 AD

4:55.0 AM

Looking north, above horizon.
No eolipse in progress.
The Sun is down.

Longitude
Time Zone
Elevation + 19°41° il
Azimuth 0° 0 fife

2zhz0m 9 |

Right Ascension i
+ 70°47° :.'

Declination

looking at where your feet would be. The
message in the Info Window will read
“Looking north, at nadir.”

Now. pressing on the up-arrow, move your
view upward as far as it will go. When you are
finally looking straight up you will once again
start turning in a counter-clockwise circle.
The message in the Info Window will read
“Looking north, at zenith.” As you turn,




looking straight up, the constellations Leo and
Ursa Major rotate above you.

The above example illustrates most of the
actions needed to follow any of the examples
in the manual. Any additional operations will
be covered in more detail under the
description of the various commands.

Note that the “astronomical time”” may differ
from the “official time” in a given place
because actual time-zone boundaries are
based on political decisions. The official time
may also vary during the year due to Daylight
Savings Time. Imagine this example: while

& File Edit Options Diew Find Clock

you are looking out the window early New
Year’s morning in Washington, D.C., your
friends are flying back from a vacation in
Hawaii. If you haven’t changed the settings
from the last example, you can now easily
move to your friends’ location. Select World
Map ... fromthe Options menu and set
your location as follows:
R0°0’N Latitude

153°30'W Longitude
Time Zone 10

Flying over the eastern Pacific (time zone 10),
your friends are five hours behind Washington,

k Al

Mon Dec 31, 1984 AD
11:55.0 PM

| Looking south, above horizon.
§ No eclipse in progress.
The Sun is down.

Latitude 20° O°N
Longitude 153°30° W

Time Zone 10

+ 67°30°
-180° 0’

6h25™.0

Elevation
Azimuth

Right Ascension
Declination - 2°29°




D.C. (time zone 5), and are just getting ready
to welcome the New Year. Click the OK
button to dismiss the World Map, and you can
see that the Clock Window shows that their
local time is 11:55 PM on December 31, 1984.

If you wish to see their view of the southern
sky, select South from the View menu.
You should now be able to recognize both the
familiar constellation Orion and the brightest
of all stars, Sirius, just to the lower left of Orion
in the constellation Canis Major. This is your
friends’ view as they celebrate New Year’s Eve.

View from Hawaii

If you are in an area affected by Daylight
Savings Time, Sky Travel may display the sky in
your area “‘offset” by one hour. To correct for
this, you may manually change the time zone
from the World Map ... functionin the
Options menu. When you are in the World
Map, you can see the Time Zone Control near
the Time Zone indicator. By pressing on this
control, you can select any time zone
regardless of your actual longitude. For
example, the normal time zone for Los
Angeles is 8, but during Daylight Savings Time
itis 7. Clicking on the down-arrow of the Time
Zone Control once after setting the proper
location and before clicking the OK button
will correct for this. This technique can also
be used to compensate when you are in a time
zone mandated by political boundaries,
instead of longitude.

Now let’s go on to learn more about the many
useful features of Sky Travel.

Save Chart to MacPaint File... 8/
Print Chart 36;

Quit 380

Save Chart to MacPaint
File...

This command generates a full-page chart
from the current display and places itin a
MacPaint™ file. The chart contains all the
information you see in the Primary Windows,
but is scaled to fill an entire page. This allows
you to use any paint program (all of them read
MacPaint files) to embellish Sky Travel charts
in any way you please.

Note: You may, of course, select any of
Sky Travel’s menu commands with
the mouse, or you may use the
command key 3 shortcuts shown
in the menu (for example “ 38 H”
selects Horizon from the
Options menuand “% ;"
selects Print Chart from the
File menu).
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Print Chart

This command generates the same full-page
chartasthe Save Chart to MacPaint
File ... command (above), but sends it
directly to whatever printer you have your
system configured for.

Quit

This command does what you have probably
come to expecta Quit command to do: Sky
Travel shuts down and gives control to the

program that started it (usually the Finder or
the MiniFinder).

World Map... &M
Information... |
Center View on Mark &R

Track Ghject Y
Track Sky Position 3R

vConstellation Lines L
vConstellation Names 3N

vPlanet Symbols S
Ecliptic Symbols 8E
Deep Sky Objects 8D
Celestial Globe Lines 86
Chart Orientation 80

vHorizon 8H

vFast Slewing 88F

The Options menu contains many choices
that affect how Sky Travel displays the sky.

World Map...

The World Map is a Mercator Projection of
Earth’s surface: Earth’s sphere is “projected”
onto a cylinder, which then is unrolled into a
flat map. Each location on Earth is defined by
two coordinates: latitude and longitude.

Latitude, measured in degrees from the
equator, goes from 0° at the equator to 90°N
at the North Pole. Note that on a Mercator
map, you cannot reach the poles. Also, the
map reproduces actual distances and areas
faithfully only near the equator but stretches
everything more and more as you go near the
poles. On the other hand, a Mercator
Projection is ideal for mapping time zones
because lines of constant longitude are
parallel lines on the map.

Longitude is measured in degrees (or hours)
from the Greenwich meridian near London,
England, and is counted positive eastward and
negative westward. Each 15° corresponds to
an hour of time difference (360°/24 hours =
15°/hour). In a Mercator Projection, each
hour zone is therefore a band 15° wide,
parallel to the Greenwich meridian, which
goes through the middle of the Greenwich, or
“Zero Time Zone.” At 180°E and 180°W, the
eastern and western longitudes superimpose
as the date line.

Selecting World Map ... brings up the
World Map Dialog, which contains a Mark
similar to the one in the Sky Window. As you
drag this Mark around the map, you will see

- the Latitude, Longitude, and Time Zone

indicators track the Mark’s location. Once
you have adjusted your position in this coarse
fashion, you can fine-tune your position by
using the controls provided. The four-
direction arrow cluster allows you to adjust
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Save Home

| Time Zone 7 ‘
Z

' 7
Mark I Time Zone Control

your latitude and longitude, and the up/down
arrows allow you to adjust your time zone.

Once you have these values as you want them,

clicking the OK button will return you to the
Primary Windows and Sky Travel will
recalculate the view from your new position.
Clicking the Cancel button returns you to
the primary windows without changing your
position.

The two other buttons, Go Home and
Save Home allow you to define one spot
on the map and one time zone as your home.
When you click Save Home the current
location of the Mark and the current value of
the Time Zone Indicator are saved on disk.

* Latitude  33°57°N
Longitude 118°15°'W ]
‘x

\Fine Position Control

From then on, whenever you click the Go
Home button these values are restored and
the Mark will jump to the point you previously
selected. Most people will probably use this
to save the location that the Macintosh is at, to
be able to get a reading of the sky in their area.

Note: The Save Home button will
not work if the Sky Travel disk is
write-protected. Go Home will
still restore the location
previously saved.

Information...

To reduce the need to look things up, Sky
Travel contains descriptions of the 88
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constellations, more than 1200 stars, and more
than 300 deep-sky objects in it’s built-in
database. You can access these by placing the
Mark over a particular object in the Sky
Window and selecting Information. ..
fromthe Options menu. Asashort cut,
you may also double-click the mouse at the
position of the object you want information
on. This has the effect of bringing the Mark to
the point double-clicked on and then asking
forinformation.

Note: To ask for information on
constellations, place the Mark
near the center of the three-letter

abbreviated name. Remember,
the Information. ..
command always gets information
on the closest object to the Mark.
You do not have to position the
Mark exactly on the center of the
object.
The information is displayed in the Info
Window. Ifitis too long for the Info Window
you may use the scroll bar to move throughit.
When you are done with the information,
dismiss it by clicking the OK button, pressing
the Return or Enter key, or simply clicking
anywhere outside the Info Window.
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The database identifies each star by its HD
number and each deep-sky object by its NGC
number. The HD numbers refer to the Henry
Draper Catalog; the NGC numbers refer to
the New General Catalog. In addition, the M
numbers are given for deep-sky objects if they
are included in Charles Messier’s catalog
dating from 1781 AD. These ID numbers will
help you search astronomical literature for
additional information, should you wish to do
so. The text also gives you pertinent
astronomical data, including mass and/or
dimensions, and distance in light years.

Track Object

When Sky Travel first starts up, this command
is “grayed,” meaning it cannot be selected.
This is because you must first select an object
to track from the Find menu. Once you
have done so, you will see that the words
“Track Object” will have changed to denote
the object you have selected. For example, if
you select Sun froomthe Find menu,
Track Object will changeto Track
Sun. When you select this command, the Sun
will always be brought to the center of the Sky
Window when Sky Travel’s clock changes
enough to cause the sky to be recalculated.
This means the view will remain “locked-on”
to the particular object you select, no matter
how it moves. If you select another object
from the Find menu while tracking is still
on, you will then be tracking the new object.

Note: Inthe Find menu, the only type
of object that cannot be tracked
by the Track Object
command are the constellations.
This is because constellations
represent fixed points in the sky,
rather than moving objects. To
track a constellation or other fixed
point,use Track Sky
Position.

Track Sky Position

By selecting Track Sky Position, you
lock the center of your view on the point that
the Mark is currently at. This means that as the
clock changes, your elevation and azimuth
where your telescope is pointing) will change
while your right ascension and declination
what your telescope is pointed at) will remain
frozen. This is the opposite of the case when
all tracking is off: your telescope remains
pointed in the same direction, but due to the
Earth’s rotation it will point at different places
in the sky over time.

If you use the Slewing Control or the Center
View on Mark command to change your
direction of view, the new point will be the
one Track Sky Position follows.

Note: Although both Track Object
and Track Sky Position
can be individually toggled on
and off, only one of them may be
on atatime.

Constellation Lines

This command controls the display of simplified
line diagrams, which are available to help
locate principal constellations, especially those
that are useful for orienting yourself in the sky.
Selecting Constellation Lines toggles
this feature on and off. By default, itis on.

Constellation Names

When Constellation Names ison
(checked), three-letter abbreviations are
displayed near their respective constellations.
Selecting Constellation Names toggles
this feature on and off. By default, itis on. As
with Constellation Lines (above),
Constellation Names is helpful for
general orientation but may get in the way if
you’re trying to identify tightly clustered
individual objects.




Planet Symbols

When Planet Symbols ison (checked),
planets are displayed as their historical symbols
to make them easy to identify. When off, they
are displayed as dots whose size represents the
planets’ relative magnitudes (brightness).
Selecting Planet Symbols toggles this
feature on and off. By default, itis on.

Note: To make planet-identification still
easier, small planetary symbols
appear next to the names of the
planetsin the Find menu. You
can simply pull this menu down

without selecting anything and
use it as a legend.
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Ecliptic Symbols

When Ecliptic Symbols isturned on
(checked) the twelve zodiacal symbols (Aries,
Pisces, Taurus, etc.) will appear along the
ecliptic, as well as small marks representing
single degrees of ecliptic longitude. The
eclipticis the path that the Sun follows
through the sky over the course of a year. The
zodiac symbols are useful for marking the
change of seasons (vernal and autumnal
equinoxes, and summer and winter solstices)
and for demonstrating precession. Selecting

this feature toggles it on and off. By default, it
is off.
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Looking northeast, above horizon.
No eclipse in progress.
The Sun is up.
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Note: You may use the Information
... command to find out more
about any of the twelve zodiacal
symbols, but the small marks
representing individual degrees
are only for visual purposes, and
do not have entries in the
database.

Deep Sky Objects

The Deep Sky Objects command
controls the display of several hundred
interesting nebulae and galaxies, and is
essential when you want to study the distant
universe. Since these objects do clutter up the

o
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more familiar star patterns and make it more
difficult to orient yourself, Deep Sky
Objects is off (unchecked) by default.
Selecting it will toggle it on and off.

Celestial Globe Lines

When Celestial Globe Lines isturned
on (checked), coordinate lines representing
right ascension and declination
(corresponding to longitude and latitude on
Earth) appear superimposed over the display.
Small crosses representing the exact north and
south celestial poles also appear. Selecting
Celestial Globe Lines toggles them on
and off. Because they take a while to draw,
they are off by default.
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Thu RApr 21, 1988 AD
1:06.2 PM

Looking northeast, above horizon.
No eclipse in progress.
The Sun is up.

Latitude
Longitude
Time Zone

+ 28°37°
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Note: When the Fast Slewing
option is on (see below),
Celestial Globe Lines are
temporarily turned off while
slewing.

Chart Orientation

Normally Sky Travel displays the sky as an
observer standing somewhere on Earth would
see it. Whenthe Chart Orientation
feature is on (checked) Sky Travel does three
things. First, it “tilts” your view so the north
celestial pole is always up. Second, it

r

Horizon

When Horizon is on (the default), every-
thing below the observer’s horizon appears
shaded. This produces the effect of a trans-

completely removes the horizon. Thirdly, it
“inverts” the display so black symbols are
displayed on a white background. These
changes put the display in a standard format
for star charts. Selecting Chart
Orientation togglesiton and off. By
default itis off.

Note: The Print Chart and Save
Chart to MacPaint File..
commands always output the
view as black symbols on a white
background, whether or not
Chart Orientation ison.
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Looking northeast, above horizon.
No eclipse in progress.
4 The Sun is up.
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lucent Earth. If you would rather not have this,
turning Horizon off will replace the
shading with a single horizon line. The




message in the Info Window will still tell you
whether you are looking above or below the

horizon, even if you can’t see the horizon line.

Note: When the Chart
Orientation commandison,
no horizon of any kind will be
displayed, printed or saved. Also,
the Print Chart and Save

Chart to MacPaint File...

commands always display the
horizon as a dashed line (as if the
Horizon command is off).

Fast Slewing

When Fast Slewing ison (the default),
Sky Travel will minimize the amount of
calculation it has to do while the view is being
slewed. It does this by not calculating the
position of the many dim stars in its database
until slewing is discontinued. Italso
temporarily shuts off the Celestial Globe
Lines command (if it is on to begin with)
until you stop slewing.
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36°
18°
90
4.5°

North
East
South
West
Opposite

The View menu allows you to change two

things: your viewing angle and your viewing
direction.

72°,36°,18°,9°, and 4.5°

These commands let you select the “lens” to

use on your “telescope.” To display objects

approximately the same size as they would

appear to the naked eye, use the 36° setting.

72° is the equivalent of a wide angle lens,
and 4.5° the equivalent of a telephoto lens.
Note: It’s always a good idea to start out

with the widest angle, making
sure that the objects you're
interested in are well centered in
the Sky Window before you
reduce the angle; otherwise, you
may lose your object outside the
view and not find it easy to
reorient yourself. For the same
reason, it’s easiest to decrease the
angle in steps, rather than
jumping from a very wide angle
down to a narrow angle.

North, East,South, West

These commands provide quick ways to look
any of the four major directions. North, for
example, causes the view azimuth to be set to
0°,and West sets it to -90°.

Opposite

Selecting this commands points the view in a
direction exactly opposite from the direction
in which you were looking. For example, if
you are looking due north (0° azimuth), and
diagonally upward (+45° elevation), selecting
Opposite will flip you to looking due south
(-180° azimuth) and looking diagonally down
(-45° elevation). One use of this command is
to find out whether any planets are in direct
opposition to the Sun. To do this, first select
Sun from the Find menu to center the Sun
in the Sky Window, then select Opposite.




| Find

O Sun

O Moon

¥ Halley's Comet
At Constellation...

¥ Mercury
? Uenus

d Mars

%4 Jupiter
kR Saturn
8 Uranus
¥ Neptune

B Pluto

The Find menu enables you to bring the
Sun, Moon, planets, constellations, and
Halley’s Comet (during its 1985-86
appearance) to the center of the Sky Window.
Instead of looking around the sky for a specific
object, you can just select the object from the
Find menu.

Sun, Moon, Halley’s Comet,
and Planets

These commands change your view so the
selected object is centered in the Sky Window,
and sets the Track Object command in
the Options menu to the name of the
selected object. For example, if you select
Mercury fromthe Find menu, the Sky
Window will be redisplayed with Mercury at
it's center, and the Track Object
command in the Options menu will then
read Track Mercury. If Track Object
is currently on, the newly selected object will
begin to be tracked.

Note: If you want to track a constellation
or any other fixed point in the sky
you must use the Track Sky
Position command in the
Options menu.

Constellation...

Selecting this command causes the
Constellation Dialog to appear containing a
list of the 88 constellations and their three-
letter abbreviations. You may use the scroll
bar to move through the list. Alternately,
typing the first letter of the constellation you
wish to find will cause the list to jump to the
first constellation beginning with that letter.
Clicking on a name will cause it to be
highlighted, and clicking on the Find
button will bring that constellation to the
center of the Sky Window. Clicking on the
Cancel button dismisses the Find
Constellation Dialog without changing
anything.
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Note: Simply double-clicking the name
of the constellation you wish to
find has the same effect as clicking
the Find button.

Reverse Clock

When Sky Travel’s clock is running it normally
runs forward, but my selecting Reverse
Clock you can watch events such as eclipses
much as one would watch a film; being able to
run the projector in both forward and reverse.
Selecting this command toggles it on and off.
Itis off by default.

Sync to Intermnal Clock
When Sync to Internal Clock ison

(the default), Sky Travel constantly monitors
the very accurate clock builtinto the

Options VUiew WALLM Clock

Find ][ Cancel

Men Mensa
Microscopium

Monoceros
Musca
Norma
Octans
Ophiuchus

Pavo

Pegasus

Perseus

Phoenix

Pictor

Pisces

Piscis Austrinus

Macintosh and sets its own clock by it. This
means you can lock the events on Sky Travel’s
screen to events in the real world as they
happen. When you turnon Sync to
Internal Clock, Sky Travel shuts off the
Reverse Clock command (if itis on) and
sets the clock speed to 1x. Assuming your
location and time zone are set for your actual
location (from the World Map...
command in the Options menu), and the
Macintosh internal clock is set correctly (from
the Alarm Clock or Control Panel
desk accessories in the Apple menu), what
Sky Travel displays will be a true
representation of the sky in your area at that
particular moment.




Reverse Clock
Sync to Internal Clock

v 0# Stopped
18 Real-Time
28
44
81
168
321
641

Display Greenwich Mean Time
Display 24 Hour Clock

Clock +1 Week 881
Clock -1 IDeek B[

Note: Changing the clock’s
forward/reverse direction or
speed will shut off the Sync to
Internal Clock command. It
may also be toggled on and off
manually by selecting it.

Ox Stopped

When this speed is selected, the clock will be
totally stopped and you will essentially be
looking at a “snapshot” of time.

1lx Real-Time

This is the default clock speed, along with
Sync to Internal Clock, whichison by
default. When this speed is selected, events in
the Sky Window will proceed at the same pace
as real life.

Note: Setting the clock for the current
time and date and selecting 1x
is not the same as selecting
Sync to Internal Clock.
There are slight differences
between the speed of the 1x
command and the speed of the
Macintosh internal clock which
would eventually become
noticable after several hours as a
“drift” away from the actual time.

Ax,4x,8x,16x,33x,and 64x

These accelerated clock speeds allow you to
view celestial events in a fraction of their
normal time. Rx is twice the speed of actual
time, and when set for 64x, events that
would normally take an hour take about a
minute to observe.

Display Greenwich Mean
Time/Local Time

This command provides an easy way to use the
standard method of telling time that
astronomers use, called Greenwich Mean
Time. Normally Sky Travel’s clock shows your
local time for whatever time zone you have set
for your location from the World Map.
Selecting Display Greenwich Mean
Time temporarily sets your time zone to 0,
and reflects this change in the Clock Window
by displaying the abbreviation GMT by the
time. Selecting this command again changes
the clock back to local time.

Display 24/12 Hour Clock
Military forces usually use a 24 hour clock
instead of the usual 12 hour AM/PM clock.
Selecting this command causes the AM/PM
indicator in the Clock Window to disappear,
and the hours of 1:00 PM - 12:00 AM to be




displayed as 13:00 - 24:00. Selecting this
command again restores the clock to 12 hour
format.

Sky Travel Operating Hints

Once you become familiar with Sky Travel and
begin using it on your own, you’ll appreciate
the many options it provides. However, for
practice purposes, use the following settings:
* Clock Rate (from the Clock menu): Ox
Stop
* View Angle (from the View menu): 72°
* Display options (from the Options
menu): Constellation Names,
Constellation Lines, Planet

Symbols, Horizon, and Fast
Slewing on (these are the defaults) and all
others off.

For the following purposes, these changes are

useful:

» Sunrise/Sunset studies: Set the clock rate to
either 16xor 32x.

* Studies of galaxies: Turn Deep Sky
Objects on and reduce the view angle in
steps.

* Plotting trajectories on charts: Use Track
Object and Chart Orientation.

Note: For special purposes, consult the
examples in this manual and the
technical notes at the end of the
manual.

A GUIDED TOUR OF THE UNIVERSE

In this section, you’ll take a tour of the
universe by way of Sky Travel. Knowledge
about the universe has affected human life
through the ages, from religion and
philosophy to such mundane tasks as being
able to get from one place to another!
Understanding of the world we live in has
increased perhaps as much in this generation
asin all the generations that preceded us. And
the more we learn, the more amazing the
universe becomes!

Geography

The first civilizations emerged in the valleys of
the great rivers: the Nile (Egypt), the Euphrates
and the Tigris (Babylonia and Assyria), the
Indus and the Ganges (India), and the Yangtze
and the Yellow (China). The fertility of these
regions provided a necessary condition for the
creation of cities: since some people could be
freed from laboring solely to provide food,

they were free to do other things. On the
other hand, as farming and the raising of
animals developed, the new societies became
more vulnerable to such vagaries of nature as
flooding and droughts. It became essential to
know when to plant, when to irrigate, and
when to harvest. Inshort, it became necessary
to understand the seasons.

Days, Years, and Seasons

Time is the dimension that prevents

everything from occurring simultaneously.
Anonymous

A solar day is the time it takes Earth to make
one complete turn around its own axis. When
a given location is facing the Sun, it’s daytime
there; when that location is no longer facing
the Sun, it’s night. Earth’s axis of rotation is
tilted 23.5° with respect to the plane of Earth’s
orbit. One result of this is that days and nights
are not of equal length except at the equator




(all year) and at other locations twice a year
(the vernal, or spring, and autumnal, or fall,
equinoxes). The following illustrations show
Earth’s shadow during its rotation and varying
orbital positions around the Sun and mercator
maps of Earth showing Earth’s shadow during
the solstices and equinoxes.
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It takes Earth 365.2422 solar days to complete
an orbit around the Sun. This is the solar year
on which our calendar is based. Afterthesolar
year is completed, the cyclic changes in day-
lightand in seasons are repeated. Like the
variations in the length of the day during the
year, the seasons are the result of the inclina-

tion of Earth’s axis of rotation with respect to
the plane of Earth’s orbit. When the North
pole is tilted toward the Sun, it’s summer in
the Northern Hemisphere. When the North
Pole points away from the Sun, it's winter. The
seasons in the Southern Hemisphere are the
opposite of those in the Northern Hemisphere.
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When these motions are translated into the
apparent movement of the Sun on the
celestial sphere, that is the way things actually
appear to an observer on Earth.
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The Sun appears to travel in a great circle,
called the ecliptic, which is tilted 23.5° with
respect to the celestial equator. This is the
angle Earth’s axis of rotation makes the Earth’s
orbit. Ancient astronomers knew the celestial
sphere extremely well, including the precise
location of the ecliptic. However, they also
believed that Earth was stationary (after all,
you can’t feel the rotation) and that it was the
center of the universe. Nevertheless, even
though we now know much more about the
spatial geometry of the universe, the sky still
appears to be the same way it did to ancient
peoples. Therefore, it’s still useful to use this
representation of the sky, and, in fact, it’s the
way it’s displayed in a planetarium!

Before you look at some specific
demonstrations, you'll want to learn the
meaning of some of the numbers that appear
in the Position Window. The four numbers at
the bottom of the window are the coordinates
of the Mark in the Sky Window. By moving
the Mark over any visible object, you can
directly read its coordinates. Elevation
and Azimuth are the direction coordinates
for a pointin the sky as seen by the observer
with reference to the horizon and a meridian
(great circle) through the zenith (the point
directly overhead). These numbers are
convenient for measuring, but they change
constantly as Earth rotates.

Zenith

!
Horizon f \

The other numbers, Right Ascension
and Declination, are the position
coordinates on the celestial sphere
corresponding to the longitude and latitude
on Earth. Maps for locating stars in the sky are
often Mercator-style maps corresponding to
the maps of Earth discussed earlier.

North

/

Vernal Equinox
Declination

Celestial Equalor

Right Ascension

South

Sunrise and Sunset at Washington, D.C.
Sky Travel lets you observe and study the
movements of the Sun at different latitudes
and times of year. The illustration below
shows how Earth’s tilted axis affects the
elevation of the Sun in the Northern
Hemisphere during the year. This is quite
familiar to people living in North America and
Europe.

Northern Hemisphere

Celestial Sphere June Solstice
\ [ {— Equinox




Now you’re ready to use Sky Travel to simulate
a familiar sunrise.

Go to the World Map Dialog by selecting
World Map ... fromthe Options menu.
Set your location to Washington, D.C.

38°B4’'N Latitide
77°0'W Longitude
Time Zone 5

Click on the OXK button to dismiss the World
Map Dialog and then set the date and time to
the following (but make sure the clock is at
Ox Stopped first):

Fridul4,1986 AD
R:45.0 AM

Now make sure that the Constellation
Lines and Planet Symbols commands
are on, and that the view angle issetto 72°.
Locate the Moon by selecting Moon from
the Find menu. You now see that it’s night
in Washington, with a new Moon just above
the horizon. Now start the clock moving by
selecting 32x fromthe Clock menu. (If
you’re in a hurry, select 64x.) Watch the
sky as the Sun rises in the constellation
Gemini. Mercury and Venus on this day rise
after the Sun; therefore, they won’t be visible
until shortly after sunset.
To confirm this, set the time to 5:00 PM, select
Moon again from the Find menu, and
watch the setting Sun.
Note: You don’t have to stop the clock.
It will pause while you are
changing its settings, and then
continue when you finish.
At about 6:00 PM, the new Moon is setting,
and at about 7:30 PM the Sun sets. You can see
the symbols of Mercury and Venus. Now that
you know where they are, turn off Planet
Symbols fromthe Options menuso you
can see the planets as bright star shapes.

Around 8:50 PM, Mercury is setting below the
horizon. Venus shines brightly in the
constellation Leo before setting below the
north-western horizon.

The Sun At Equinox Near the Poles

Near the poles, the Sun moves parallel to the
horizon. The Sun is above the horizon all
summer and below it all winter. At the
equinox, it moves along the horizon. In the
Northern Hemisphere, it moves to the right; in
the Southern Hemisphere, it moves to the left.

North and South Poles
N
Celestial Sphere

June Solstice
w Equinox
ecombm Solstice

v
S

Equinox Near the North Pole

Sky Travel can demonstrate the equinox near

the North Pole, where the Sun moves to the

right. Make sure the clock is stopped, then go

to the world map, and drag the Mark to the

vertical center line (the Greenwich meridian),

and as far north as it will go.

Note: Since this is a mercator-style map,

you cannot quite get to the exact
North Pole, and so your setting
will be approximate, but sufficient
for our purposes.

83°40'N Latitude

0°0’W Longitude
Time Zone O

Horizon




Set the date and time:

Mon Mar 19,1984 AD
12:00.0 PM

Locate the Sun using the Find menu, then
move it to the left side of the Sky Window by
pressing on the right-arrow (remember, this is
the one that points to the right, not the right-
most one) in the Slewing Control. Set the
clock rate to 32x, and observe that the Sun
now moves to the right along the horizon,
neither setting nor rising.

Equinox Near the South Pole

Follow the steps below to see the same
phenomenon near the South Pole. Notice
that here the Sun moves to the left.

Stop the clock, and return to the World Map.
Leave the Mark at longitude 0°, but drag it as
far as it will go toward the South Pole. Set the
date and time to the following:

Thu Mar 22,1984 AD
12:00.0 PM

Find the Sun again, and move it to the right of

the Sky Window by pressing on the left-arrow

in the slewing gadget. When you start the

clock, the Sun will now move to the left along

the horizon, again neither rising nor setting.

Note: Repeating these examples with

the Ecliptic Symbols,
Celestial Globe Lines, and
Chart Orientation
commands activated is
particularly instructive. The Sun
crosses the ecliptic at the first
point of the zodiac sign Aries,
whose symbol is the ram’s head.

Sunrise and Sunset at the Equator

At the equator, the celestial North and South
Poles lie at the horizon. Both the Sun and the
stars rise straight up on the east side and set
straight down on the west side of the horizon.

Equator

Equinox

June Solstice December Solstice

N\

Celeslial Sphere

Horizon

Follow the following instructions to see both a
sunrise and a sunset at the equator.

Stop the clock and return to the World Map.
Set both the latitude and longitude to 0° (the
equator at the Greenwich meridian). Set the
date and time as follows:

Wed Dec R1,1983 AD
5:00.0 AM

Find the Sunso thatitis at the center of the Sky

Winow, then turn on the clock. The Sun now

rises straight up from the horizon, as do the

stars. To watch the Sun set, change the time to

5:00 PM and watch the Sun go straight down,

followed by the same motion of the stars.

Note: If you repeat this example with

Ecliptic Symbols,
Celestial Globe Lines, and
Chart Orientation on,the
movement of the Sun through the
first point of Capricorn on the
ecliptic marks and the exact time
of the winter solstice.

Astronomy

Each location on Earth is defined by two
coordinates, latitude and longitude. Similarly,
each location on the celestial sphere is
defined by a similar pair of coordinates,
declination and right ascension. Declination,
measured in degrees from the celestial




equator, goes from 0° at the equator to +90° at
the celestial North Pole and -90° at the
celestial South Pole.

Note: Three sky orientation maps are
shown on page 28. You’ll use
them later to help you find your
way around the sky.

Note that on a Mercator map, you cannot
reach the poles; also, the map faithfully
reproduces stellar distances and shapes of
constellations only near the equator, but it
stretches everything more and more as you
move closer to the poles. On the other hand,
a Mercator projection has the advantage that
the circles of constant declination and right
ascension, which intersect each other at right
angles on the sphere, become sets of parallel
lines, which still intersect each other at right
angles on the Mercator projection.

Right ascension is measured in degrees (or
hours) from the vernal equinox, marked by
the ram’s head symbol of the first point of
Aries (the location of the Sun on the first day
of spring, when day and night are of equal
length). Asis the case for longitudes on Earth,
each 15° esponds to an hour of time
difference (360°/24 hours =15°/hour). The
Mercator map displays line diagrams of
prominent constellations; these are
particularly useful when you’re trying to
orient yourself in the sky. A few geometrical
star patterns commonly used by navigators are
also shown. Since the polar regions cannot be
shown on a Mercator map, yet are important
regions of the sky, special projections of both
the north and south polar regions are also
shown. All of these maps are discussed in
more detail in following sections.

The Position Window displays the right
ascension and declination of the Mark
location. Therefore, if you know these
coordinates for any given sky object, you can
readily locate it on the map and on your
screen. The right ascensions and declinations
of the bright stars used in navigation, as well as
those of some other prominent stars, are listed
in a table in the back of this manual.

Star Recognition/Constellations
The Ram, the Bull, the Heavenly Twins,
Next the Crab, and the Lion shines,
The Virgin and the Scales,
The Scorpion, Archer, and Seagoat,
The Man that pours the water out,
And the Fish with the glittering scales.
from an old English nursery rhyme

During the last two millennia BC, astrologer-
priests in the ancient Assyrian and Babylonian
civilizations named particular star patterns
after their gods, heroes, and animals. The
Greeks later changed the names to those of
their own gods and heroes, and the Romans,
when they adopted the basic Greek
mythology, gave most of the constellations the
Latin names we still use today.

Although the grouping of stars into
constellations has no scientific meaning, some
constellations are still useful as signposts when
you want to orient yourself in the sky. Sky
Travel displays simplified line diagrams of
some of the more conspicuous constellations
and gives an abbreviated name next to every
constellation. When you no longer need
these aids, or if you’re already an expert star-
finder, you may prefer to turn these options
off. However, if you’re a beginner, you may
find these features helpful.
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Look at the sky orientation maps above.

Note that certain stars are “pointer stars”. By
drawing imaginary lines through them, you
can more easily locate other stars. The most
useful instances are marked on the maps.

A well-known example of using pointer stars is
that of finding Polaris by means of the Big
Dipper (Ursa Major), perhaps the most
familiar constellation in the northern sky (see
the North Polar Region Map). A line extended
through the stars Merak and Dubhe in the Big
Dipper leads directly to Polaris, the North Star.
Polaris, in turn, is the last star in the handle of
the constellation the Little Dipper (Ursa
Minor). Note also that a curved line extended
through the handle of the Big Dipper leads to
Arcturus, the bright star at the point of the
kite-shaped constellation Bootes, and farther
down to the bright star Spica in the rather

inconspicuous constellation Virgo (see the
Equatorial Region map).

'/—‘\‘

NS ~ # Dubne

\

# —— # Merak

If you go through Polaris, almost directly
opposite the Little Dipper you'll find the
constellation Cassiopeia, easily recognized by
its open-W shape. Farther away from Polaris
in the same direction is the readily
recognizable “Great Square” of Pegasus, with
the bright stars Alpheratz and Markab in

-opposite corners. A line from Markab

through Alpheratz leads directly to Marfak in
Perseus and to Capella in Auriga. A line
through the opposite corners of the square
leads to the constellation Cygnus (also called
the Northern Cross because of its shape) and
farther on to the bright star Vega.
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Orion, one of the most beautiful
constellations of the northern sky in winter, is
another good starting point because of its
prominence. A line through the corner stars
Rigel and Betelgeuse leads directly to Castor
and Pollux, the twin head stars in Gemini.




Another line through the stars in Orion’s belt
leads on one side to Aldebaran in Taurus, and
on the other side to Sirius, the brightest star in
the sky, in the otherwise inconspicuous
constellation Canis Major.

Other useful examples are the line that can be
drawn through two of the stars in the sail-
shaped constellation Corvus, leading to Spica,
and the line from the Southern Cross (Crux) to
the bright stars Hadar and Rigil Kentaurus.

Three conspicuous triangles, which are not
constellations, are used by navigators because
the triangles contain very bright stars and are
easy to locate. They are Procyon-Betelgeuse-
Sirius, Deneb-Vega-Altair, and Arcturus-
Denebola-Spica, where Denebola is the star at
the tail of the constellation Leo.

Signposts like these will help you locate many
less conspicuous but nevertheless very
interesting objects in the sky. By pointing and
clicking the mouse button, you can identify
any visible object with Sky Travel. As an
exercise, use the Constellation. ..
command in the Find menu to locate the Big
Dipper (UMa). Then identify the individual
star in the constellation.

Telescope Stars and Galaxies
Many stars that appear as single stars to the
naked eye are actually double stars visible
even at relatively low magnification. Sky
Travel can be used as a low-power telescope
so that you can see this phenomenon. One
example is Epsilon Lyrae.
Set your location on the World Map to Kansas
City:

39° 7'N Latitude
94°39'W Longitude
Time Zone 6

Make sure the clock is stopped, then set the
date and time to the following:

Wed Aug 28,1985 AD

11:00.0 PM
Set the view angleto 72°. From the
Options menu, make sure
Constellation Names and
Constellation Lines commands are
turned on. Select Constellation... from
the Find menu, and select the constellation
Lyra ( Lyr). The characteristic connected
diamond/triangle pattern with the bright star
Vega is now in the center of the screen. Look
at the rather faint star above and to the right of
Vega.

At this magnification it looks perfectly normal.
Now lower the view angle to 36° using the
View menu. Place the cursor on the faint
star, and select Center View on Mark
fromthe Options menu to center the
object in the Sky Window. Gradually lower
the view angle, recentering the object each
time. When youreach 4.5°, turn off
Constellation Lines, and you will see
the faint star has resolved into two stars.
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Place the Mark in turn over each individual
star, and select Information ... from the
Options menu (or just double click the
mouse button on the star). The stars are
Epsilon-1and Epsilon-2 Lyrae.

Here’s how to resolve the great galaxy in
Andromeda into three separate galaxies:
Stay in Kansas City, the same day and same
time. Increase the view angle back to 72°;
then select Andromeda ( And ) from the
Constellation command in the Find

r

Phases of the Moon

The phases of the Moon are caused by the
position of the Moon, in relation to the Sun, as
seen from Earth. According to a Latin saying,
the Moon fools you (“Luna fallit”’): when it
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menu. Now turnon Deep Sky Objects
from the Options menu. Place the cursor
on the conspicuous oval galaxy just to the left
of Andromeda. Select Center Cursor from the
Options menu to center the galaxy on the
screen. Gradually lower the view angle as
before. You now see two small satellite
galaxies near the Andromeda Galaxy. Use the
Information ... command from the
Options menu to identify all three.

Wed Aug 28, 1985 AD
11:00.0 PM

Looking east, above horizon.
No eclipse in progress.
The Sun s down.

Right Ascension
Declination

looks like a C (“crescit” means “it increases”),
it’s actually decreasing; and when it looks like
a D (“decrescit” means “it decreases”), it’s
actually increasing. The illustration shows why
that’s so.
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Sky Travel calculates the Moon’s phases during
regular updates of the Moon’s position in the
sky. This s illustrated in the following example
of the Moon phases as seen from New York
City during the month of December 1983:

Day NY Time Moon Phase
Dec4 8:47.0 AM New

Dec 11 4:00.0 PM 1st Quarter
Dec 19 7:00.0 PM Full

Dec 26 11:55.0 PM 3rd Quarter

Set the World Map to New York City:
40°43’N Latitude
74° 1'W Longitude
Time Zone 5
Set the date and time:
Sun Dec 4,1983 AD
8:47.0 AM
The Moon is now new. In order to see it, set
the view angle to 4.5°, and locate the Moon
using the Find menu.
Reset the date and time:
Sun Dec 11,1983 AD
4:00.0 PM
Find the Moon, which is now in its first
quarter.
Change the date and time to the following:

Mon Dec 19,1983 AD
9:00.0 PM

Gibbous  Quarter  Croscont

On this date, the Moon is full.
Finally, set the date and time to the following:

Mon Dec 26,1983 AD
11:55.0 PM

Now the Moon is in its third quarter.
Solar Eclipses

WARNING! Never look directly at the Sun,

even during a total eclipse!

A solar eclipse occurs when the Moon blocks

the Sun’s light at some location on Earth.

Although the Moon is much smaller than the

Sun, the Moon is closer to Earth, so the

apparent sizes are quite similar as seen from

Earth. When the Moon almost completely

covers the solar disk, we call the eclipse total.

One of the first reliable records of a solar

eclipse dates from the Greek historian

Thucydides. He reported an eclipse that

occurred in the afternoon on August 3in the

year 431 BC, The eclipse was not total, but

enough of the Sun was darkened to make

some bright stars appear. The location of the

observation was not mentioned, but since

Thucydides was an Athenian, it’s assumed to

have been Athens.

Now you can look at that eclipse with Sky

Travel.

Take a journey to Athens on the World Map:

37°568'N Latitude

R3°43'E Longitude

Time Zone -2

Set the date and time:

Wed Aug 3,431 BC

4:30.0 PM
Note: Remember to set the year to BC.

Because of the large change in
time, when you finish setting the
clock, the mouse pointer will
change to the Precessing symbol




for a few moments while Sky
Travel calculates the Earth’s
precession.

Set the view angle to 72°. Make sure the
Planet Symbols option is on, and find the
Sun. Next, use the Slewing Control to move
the Sun to the upper-left part of the screen.
Now set the clock rate to 32x. The eclipse
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Next, you can try to confirm an eclipse
predicted to occur in the future — for
example, the one predicted for June 30, 1992:
You have decided that the island of Tristan da
Cunha might be a favorable place to observe
and photograph this eclipse. So go to the
World Map and set your location:

37°15'S Latitude

12°30'W Longitude

Time Zone 1

starts before 5:00 PM and is over by 6:45 PM.
The illustration below shows the screen at 5:45
PM, local Athens time. Note the crescent Sun
and the planets Mercury, Venus, and Mars
against a sky which was-about as bright as
twilight at that time, confirming Thucydides’s
report!
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Wed Aug 3, 431 BC
5:45.0 PM

Looking west, above horizon.
Solar eclipse in progress.
The Sun is up. gt

37°S8°N
23°43°E

-2

il Elevation + 38°56°
i Azimuth - 66°44°
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Set the date and time:’

Tue Jun 30, 1992 AD

9:35.0 AM
Set your view angle to 36°, and center the
Sun on your screen; then use the Slewing
Control to move the Sun to the right side of
the screen. Next, set the clock rateto 16x,
and you’ll see an eclipse take place.

Now, before you pack your bags for Tristan da




Cunha, you realize that total solar eclipses are
extremely location-dependent because of the
small diameter of the Moon’s shadow; and
under even the best conditions, totality last
only about five minutes. The eclipse is not
total at Tristan da Cunha. Nor is it total at the
island of St. Helena. But you could schedule
your trip so that you’d be sailing from one
island to the other and be at 24°56’ latitude
and at the longitude of Tristan da Cunha at
around 9:30 AM local time. That way
(weather permitting) you'd see a total eclipse
by 11:00 AM!

Note: For observations requiring
pinpoint accuracy, such as
determining the precise path of
totality of a solar eclipse, you'll
need specialized computer
programs. Nevertheless, Sky
Travel gives a quick and rather
accurate account of the main
features of a wide range of
celestial phenomena over very
large time spans. A more detailed
discussion of the structure and
precision of the program appears
in Technical Notes in the back of
this manual.

Lunar Eclipses

A lunar eclipse occurs when Earth blocks the
line of sight between the Sun and some
location on the Moon. If the shadow of Earth
completely covers the Moon’s surface, the
lunar eclipse is total. Therefore, though solar
eclipses can occur only when the Moon is
approximately new, lunar eclipses can occur
only when the Moon is full. Total lunar
eclipses are less frequent than solar eclipses,
but they’re much more common from any
given location; lunar eclipses are always
visible from about half the surface of Earth,

while solar eclipses are visible only from
within the narrow path traced on Earth by the
Moon’s small shadow. Examples of famous
historical lunar eclipses appear on page 49.

Planetary Transits

The inferior planets, Mercury and Venus, are
closer to the Sun than Earth is. Therefore,
when they block the line of sight between the
Sun and some position on Earth, a planetary
transit occurs.

A planetary transit is similar to a solar eclipse,
which is caused by the Moon blocking the line
of sign between the Sun and some location on
Earth. However, planetary transits are much
more difficult to observe, in the case of
Mercury because of the small apparent size of
the planet and in the case of Venus because of
the infrequency of the transits.

Early attempts to observe transits of Mercury,
the smallest and innermost of the two planets,
were unreliable due to confusion with Sun
spots. The first recorded Mercury transit was
one predicted by Johannes Kepler to occur on
November 7,1631 AD. Kepler himself died the
year before, but an astronomer in Paris, Pierre
Gassendi, observed and recorded the path of
the planet across the surface of the Sun. A
second Mercury transit predicted to occur on
May 3, 1661 AD, was observed independently
by the Polish astronomer Johann Hevelius
from Gdansk, Poland, and by the Dutch
scientist Christiaan Huygens from London
(Gingerich: 1983).

Here’s how you can verify these early
recorded transits of Mercury. To see the
Mercury transit observed by Gassendi, set
your location to Paris on the World Map:

48°52’'N Latitude
R°20’E Longitude
Time Zone O




Set the date and time:

Fri Nov7,1631 AD
7:00.0 AM

Inthe Options menu, turn off everything
except Horizon and Fast Slewing. Set
the view angle to 4.5°, then select Sun
fromthe Find menu so the Sun is centered
in the Sky Window. Now select Mercury
fromthe Find menuand Track Object
from the Options menu (which will read
Track Mercury at thattime). Set the
clock rate to 64x. You will see the Mark
move slowly across the face of the Sun during
the day, emerging as a tiny dot in the center of
the Mark at 10:16 AM.

Now stop the clock, and adjust the World Map
location for London, and date and time values
to the following:

51°30'N Latitude

0°10’'W Longitude
Time Zone O
Tue May 03,1661 AD

12:01.0 PM

Again, center the Sun in the sky; then center
Mercury. Set the clock rate to 64x, and
observe the result. This is the Mercury transit
observed by Huygens.

The first predicted transit of Venus was
calculated from kepler’s laws to occur on
December 7,1631 AD, but unfortunately the
Sun was below the horizon from Europe at the
time of the transit, so no observation of the
transit could be made from there. The next
transit was predicted to occur on December 4,
1639 AD, and was observed and recorded by
the English astronomer and clergyman
Jeremiah Horrocks. No Venus transits have
occurred during the past 100 years. The next
transits will occur on June 8, 2004, and on June
5-6, 2012 (Janiczek and Houchins: 1974).

To check both a past and a future Venus
transit, first stop the clock. If you're
continuing from the previous example, stay in
London; otherwise, go back to the World Map
and set the location for London:

51°30’'N Latitude
0°10’'W Longitude

Time Zone O

Set the date and time:

Sun Dec 4, 1639 AD
3:00.0 PM

Find the Sun. Set the clock rate to 64x. This
is the Venus transit observed by Horrocks.
Stop the clock again and go to New York. Set
the place and date:

41°43’N Latitude

74°01’'W Longitude

Time Zone &

Tue Jun 8, 2004 AD

4:00.0 AM
Find the Sun. Set the clock rate to 64x. This
is one of the Venus transits yet to come.

Planetary Occultations

Planetary occultations are eclipses of one
planet by another planet or by the Moon, as
seen from Earth.

The Greek philosopher Aristotle observed and
recorded an occultation of Mars by the half-
Moon on May 4, 357 BC. He described how
Mars disappeared behind the dark side of the
Moon and then reappeared on the bright side.
Aristotle used this observation as conclusive
proof that the Moon is closer to Earth than
Mars is and commented that similar, earlier
observations by the Egyptians and Babylonians
had proven this to be the case also for the
other then-known planets (Richardson and
Clark: 1978).




Here’s how you can re-create this personal
observation by Aristotle. Set your location to
Athens and your date and time as follows:
38°00’'N Latitude
R24°00’E Longitude
Time Zone -2
Fri May 4,357 BC

6:00.0 PM
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As a young man in Tubingen, Germany,

Johannes Kepler observed and recorded a rare

occultation of Jupiter by Mars on January 19,
1591 AD. Because of the distinct red color of
Mars, Kepler was able to see that Mars
covered Jupiter rather than the other way

Find Mars, turnon Track Object (which
will read Track Mars),set the view angle
to 4.5°, and make sure the Planet
Symbols option is off.

Then set the clock rate to 16x. Watch from
6:00 PM to about 10:00 PM. Mars passes
behind the dark side of the Moon and
reappears on the bright side, just as Aristotle
observed.
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Fri May 4, 357 BC
11:30.0 PM

ooking west, above hor
No eclipse in progress.
The Sun is down.

+ 21°51° | [

- 83°52°
Right Ascension ghz4m 4
Declination + 17°53°

around. He therefore concluded —based on
the Artistotelian argument previously
explained — that Mars is closer to Earth than
Jupiter is. You can observe this event from
Tubingen, near Stuttgart, West Germany.




48°5'N Latitude
7°4'E Longitude
Time Zone 0O

Sat Jan 19,1591 AD
7:00.0 AM

Find Jupiter, then Mars; note their proximity.
Setyour view angle at 36° and the clock rate
to 32x. Then watch the motion of the two
planets.

An occultation of Venus by the Moon on July
17,1974 AD, is an example from recent times.
The occultation took place in the early
morning hours, and observations in the
United States were particularly favorable from
Florida. Using the method described above,
set Sky Travel to the correct time and place
and see this event for yourself.

Planetary Alignments and the Jupiter
Effect

One of the most striking astronomical
spectacles occurs when several planets are
visible within a narrow field of view. In ancient
and medieval times, such spectacles were
regarded as portents of great catastrophes.
Even quite recently, predictions of natural
disasters have been widely reported. Present-
day fears are based on concerns that the
combined gravitational pull of several planets
might trigger major Earthquakes and tidal
waves on Earth. On September 15, 1186 AD,
Mercury, Venus, Mars, Jupiter, Saturn, and the
Moon were all close to the Sun and within a
narrow view angle of 12°. This rare configura-
tion of planets had been predicted several
years before by the astrologer John of Toledo.
It was taken as an omen of great calamities and
Earthquakes. Near panic ensued, and the
location of the planetary clustering in the
Libra sign of the zodiac was taken as a partic-
ularly ill omen for high winds. People sought

refuge in cellars and caves. The windows of
the Imperial Palace in Byzantium were
boarded up, and the Archbishop of Canterbury
ordered fasting. Finally, the month of
September came, and the predicted planetary
configuration occurred without any of the
feared consequences on Earth.

The illustration on the opposite page
represents this planetary alignment:

You can re-create this view by journeying to
western Europe:

49° 0'N Latitude
5°0'W Longitude
Time Zone O
Mon Sep 15,1186 AD
5:00.0 PM

Make sure the clock is stopped. From the
Options menu, turn off the tracking
commands and turnon Planet Symbols.
Set the view angle to 18°. Now find Saturn,
and you will get a display similar to the
illustration on the opposite page.

On February 5, 1524 AD, another close
planetary clustering was predicted, this time in
the Aquarius sign of the zodiac. Another
deluge was predicted, serious flooding was
feared, and many people took refuge in boats.
The year turned out to be an unusually dry
one (Ashbrook: 1973).

On March 10, 1982 AD, the eight planets
(excluding Earth) were within about one
quadrant of the sky. The event, which scarcely
qualified as an “alignment,” was nevertheless
forecast (by highly unscientific sources) to
trigger a major Earthquake in California and to
result in enhanced solar activity. A “Jupiter
effect” was widely discussed in the news media.
For the record, California did not break off at
the San Andreas Fault and slide into the Pacific
Ocean in 1982 (Thompson: 1981).
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On February 26, 1953 BC, the five planets
Mercury, Venus, Mars, Jupiter, and Saturn
were within a view angle of less than 4°. No
historical record exists of this ancient
planetary clustering. You have an opportunity
to practice with Sky Travel by demonstrating
the planetary alignments described above.
For each example, your location can be
anywhere on Earth.

Planetary Retrogression

Since ancient times, the planets have been
recognized as being different from the stars
because they move relative to the background
of fixed stars. This is reflected in the word
“planet,” which means “wanderer.” The
superior, or outer, planets, which are more
distant from the Sun than Earth is, at times
show a peculiar motion: they temporarily
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Mon Sep 15, 1186 AD
5:48.0 PM

Looking west, above horizon,
No eclipse in progress.
l The Sun is setting.

i Latitude
# Longitude

Time Zone

i Elevation +12°19
# Azimuth -100°15°

Right Ascension 12435 3| |
Declination + 2°41° |

appear to move backward. The astronomer-
geographer Ptolemy of Alexandria in the 2nd
century AD rationalized this observation by
suggesting that a planet moves in a circle
about a center, which itself orbits the Sun.

The laws of planetary motion discovered by
Johannes Kepler provided the true
explanation for this phenomenon, which is
now called “retrogression.” Actually, planets
don’t move backward when seen from the
location of the Sun. The reason that they
appear to do so is that we observe the planets
from Earth, which is itself a moving planet.
The closer a planet is to the Sun, the greater its
orbital speed. Therefore, when a planet is
near “opposition” — that is, when it’s located
in the opposite direction of the Sun as seen
from Earth — the line of sight from Earth to the




planet changes direction relative to the
celestial sphere background as Earth catches
up with and then overtakes the outer planet.
Because the Earth and the planets are not in
exactly the same orbital planes, a retrogression
usually appears as a shallow loop.

The retrograde motion of Mars may best be
seen by finding Mars at the time of opposition
and then watching its motion relative to a
fixed pointin the sky. With the clock stopped,
set the following date (time of day doesn’t
matter for this demonstration):

Wed Apr 6, 1986 AD

Set your view angle to 36°, turn on the
Constellation Lines, Constellation
Names, and Chart Orientation
options, then find Mars. You will see that to its
lower-left is the bright star Nunki in the
constellation Sagittarius. Place the Mark on
Nunkiand turnon Track Sky Position.
This will keep Nunki centered in the Sky
Window and provide us with a point of
reference. .
Now, repeatedly using the Clock +1 Week
command in the Clock menu (which can be
conveniently accessed from the keyboard with
#]), observe the motion of mars until
September 30. Mars moves to the left, away
from Sagittarius. Then it slows, stops, reverses
direction and makes a loop inside the
constellation before once again moving away
to the left.

Mars Retrogression

Precession, Polestars, and the Zodiac
This is the dawning of the age of Aquarius.
from the Broadway musical Hair
Observers of the northern sky are familiar with
the polestar (Polaris), also called the North Star.
This star makes it particularly easy to determine

the cardinal directions in the Northern
Hemisphere at night. (There is no similarly
easy method in the Southern Hemisphere
because of the lack of a “South Star.”) As
mentioned earlier, you can easily locate the
North Star by extending a line through two
pointer stars in the constellation the Big
Dipper (Ursa Major). The North Star is formally
known as Alpha Ursae Minoris, which means
“the first star of Little Bear.” Little Bear is
another name for the Little Dipper. However,
Alpha Ursae Minoris has not always been the
North Star, nor will it always continue to be.

Ancient astronomers and navigators did not
use Polaris as the North Star. In fact, the
“North Star” at the time the Great Pyramids
were built was the star Thuban in the
constellation Draco. The North Star today is
about 1° from the true pole, and by the year
2102 AD it will reach its closest proximity to the
true north of about 1/2°. The next polestar
will be the star Gamma Cephei in the year 4145
AD, and the one after that will be the star
Alpha Cephei in the year 7530 AD. Both stars
are in the constellation Cepheus.

Ecliptic Pole




The reason for the changing polestars is that

Earth’s axis wobbles like that of a spinning top.

The wobbling, or precession, has a time cycle
of 26,000 years, after which the sequence of
polestars will repeat itself.

Sky Travel takes Earth’s precession into
account, so you can demonstrate for yourself
the past and future polestars mentioned
above. The polestar in the distant past will be
shown in a later example. Here you can see
the appearance of the northern polar region
farinto the future.

Observe the following example from
Copenhagen just after sunset:

r
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55°41'N Latitude
12°41'E Longitude
Time Zone -1
Fri May 4, 1945 AD

11:30.0 PM
Set your viewing angle to 72°, select
Constellation. .. fromthe Find menu,
and choose Ursa Minor ( UMi) from the
constellation list. You now see the current
polestar, Polaris, in the center of the screen.
Now turn on the Celestial Globe Lines
option. You will see a small cross where the
true north celstial pole is.

Fri May 4, 1945 AD
11:30.0 PM

Looking north, above horizon.
No eclipse in progress.
The Sun is down.

shy Trayel

Latitude SS°41°N | K
Longitude 12°41°E | ;
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Next, change the year to 4145 AD. Corrections
for precession require recalculation of all star
coordinates on the celestial sphere. While this
is happening, the cursor changes to a small
sphere. When the calculations are done,

Ve

notice the shift in positions of the stars near
the North Pole. Specifically, the polestar is no
longer Polaris but instead is Gamma Cephei.
To confirm this, use the Information...
command on the new polestar.
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Tue May 4, 4145 AD
11:30.0 PM

Looking north, above horizon.
No eclipse in progress.
The Sun is down.

Sty Trayel

Latitude !
Longitude 12°41°E

Time Zone -1

Elevation + 47°16°
Azimuth - 6°41°

Right Ascension 4hM3m 2
Declination + 80°37°




Now repeat the procedure for the year
7530 AD.
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Another effect of precession is that the vernal
equinox, the autumnal equinox, and both
solstices change slowly during the same period
of 26,000 years. You can see this by comparing
the illustration on page 40, which shows the
wobbling of Earth’s axis, with the illustration of
the celestial sphere and ecliptic above.

The celestial equator will turn in relation to
the ecliptic when Earth’s axis of rotation
precesses. Thisis because the celestial equator
and Earth’s equator are in the same plane.

One effect of this is that the star coordinates
on the celestial sphere are not constant over
long periods of time. It may seem strange at
first that astronomers would choose a moving
origin for measuring right ascension. Never-
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Sun May 4, 7530 AD
11:30.0 PM

Looking north, above horizon.
No eclipse in progress.
The Sun is down.

Shy Trayel

Latitude
Longitude

SS5°41°N |
12°41°E
Time Zone -1

Elevation + 42°55°
Azimuth - 6°48°
zhqom 3
+ 76°30°

Right Ascension
Declination

theless, the advantage is that this method
keeps the Sun’s position independent of
precession, and for all inhabitants of Earth
—including astronomers — the Sun and the
seasons are more important for everyday life
than the stars.

The star background changes slowly with
respect to the position of the Sun. This is more
obvious in relation to the zodiac
constellations, located in a narrow band along
the ecliptic. This is also the region in which all
the planets move, because their orbital planes
are tilted only moderately relative to Earth’s
orbit. This ecliptic band is thus the region of
the sky where all the action is, and it is the
region that captured the attention of the




astrologer-priests in the Babylonian and
Assyrian civilizations. They divided the
ecliptic into twelve 30° intervals, or signs, and
named them after the principal constellations
located in those sections at the time. The
Greeks later coined the name “Zodiac”
(meaning “the circle of animals”) for the
ecliptic constellations. In the 2nd century AD,
greek astronomer-geographer Ptolemy of
Alexandria described and published
illustrations of most of the constellations.
Those illustrations are still in use today: you
can see them by turning on the Ecliptic
Symbols option.

When the Babylonians made their observations
around 2000 BC, the vernal equinox was in the
constellation Aries. Two thousand years later,
the vernal equinox was moving into Pisces;
today, it’s approaching the constellation
Aquarius. In asense, precession makes the
ecliptic into a gigantic clock with a 26,000-year
period for a single turn of the “hand,” the
vernal equinox. The circular motion of the
celestial poles, causing changes in the star that
happens to be closest to the North Pole, is just
another look at the same clock from a different
direction. The Sunis at the symbol for Aries
on the first day of spring (vernal equinox) and
at the symbol for Libra on the first day of fall
(autumnal equinox). The summer solstice
occurs when the Sun is at the symbol for
cancer, and the winter solstice occurs when
the Sun is at the symbol for Capricorn. The
23.5° northern and southern parallels on Earth
are named the tropics of Cancer and Capricorn,
respectively, because of the location of the
Sun on these signs at the solstices.

Precession causes the signs of the zodiac to
move relative to the constellations of the
zodiac. For example, at the time of the con-

struction of the Stone Lion of Nimrud Dagh
(see page 52), the head and shoulders of the
constellation Leo were several degrees into
the sign of Cancer, and the western part of the
constellation Virgo overlapped the eastern
part of the sign of Leo. Today the zodiac signs
are nowhere near the constellations for which
they were named.

Halley’s Comet

Of all the comets in the sky,
There’s none like comet Halley.
We see it with the naked eye

aidiperiodically Harold Spencer Jones

Comets are relatively small, frozen bodies that
revolve around the Sun. When a comet passes
closetoalarge body, such asalarge planet, the
comet’s orbit is perturbed. For this reason, the
trajeectories of comets are changeable. Comet
“tails” are vapor and dust clouds formed when
the frozen “head” of the comet passes close to
the Sun and is heated. This process eventually
depletes the comet. Since the tails of comets
can be extremely large and spectacular,
appearances of comets have been recorded
since ancient times.

Halley’s Comet was first observed and recorded
in 240 BC. Subsequent returns have been
extensively recorded around the world. A
particularly famous appearance is shown on
the Bayeux tapestry, a 2-foot-high, 239
foot-long crewel embroidery made in medieval
times in Normandy, which depicts the Norman
conquest of England. The comet appeared as
William the Conqueror set sail for England and
was taken as an omen presaging the fate of
King Harold, who later was defeated and slain
at the Battle of Hastings in 1066 AD.




Courtesy: William the Conqueror Center, Bayeux, France

The Latin inscription on the tapestry means
“men marvelling at the star.” Note the
messenger bringing the bad news to King
Harold and the invasion ships below the king
(Setton: 1966).

The comet is named after the British
astronomer Edmund Halley, who personally
observed the “Great Comet” of 1682 AD.
Halley was a close friend of Isaac Newton and,
in fact, was instrumental in getting Newton's
theory of gravitation published. Working from
Newton’s ideas, Halley compared the appear-
ance of the 1682 comet with the records of
earlier ones and concluded that this was a
periodic comet. He determined its orbit and
correctly predicted subsequent appearances.
In recognition of this accomplishment, the
comet was later named for him. The comet
appears about every 75 years; the last appear-
ance before the 1985-86 one was in 1910 AD
(Bortle: 1985).

Several space probes were sent toward the
comet to carry out scientific studies and to
transmit closeup pictures back to Earth, making
this visit a particularly spectacular and exciting
event (Berry: 1987).

Sky Travel can demonstrate the trajectory for
the 1985-86 passage of Halley’s Comet. The
closest approach to the Sun (the perihelion)
was early February 1986. The best time for
observation was from September through
December 1985 (especially in the Northern
Hemisphere) and from March through July
1986 (especially in the Southern Hemisphere).
Since the comet’s tail is formed by evaporation
as its head passes close to the Sun, a periodic
comet is more spectacular on its return trip.
You can watch the 1986 spring trajectory of
Halley’s Comet across the sky. To observe the
comet as it appeared from Wollongong, New
South Wales, set your location:

34°4'S Latitude
150° 8'E Longitude
Time Zone-10
Set your date and time to the following:

Sat Apr5,1986 AD
11:30.0 PM

_Now that you’re in the active comet-watching

period, you can select Halley's Comet
fromthe Find menu to bring it to the center
of the Sky Window. From the Options
menu turn on Track Object (which will
read Track Halley's Comet),
Constellation Names,and
Constellation Lines. Use aview angle
of 7R° or 36°. Now go forward one day
(from April 5th to April 6th), and watch the
display. Notice as the Comet moves away from
the constellation Scorpius. Continue to
advance by days and observe the comet’s path.
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Until the middle of March, the comet
remained below the horizon in Wollongong,
but it was rather inconspicuous anyway.
However, from the end of March to Early
April, the comet was well above the horizon,
and a large tail was visible. By mid-April, the
comet show was about over for observers
without telescopes.

Southern Constellations

If you live in the Northern Hemisphere, you
may be curious about the less familiar southern
constellations. To learn more about them,
move the Mark over the center of a desired
constellation abbreviation or celestial object
and select Information... fromthe
Options menu (or simply double-click the
mouse button on the name or object). The
information appears in the Information

Options Uiew Find Clock

| M.u_s

Sat Apr 5, 1986 AD
11:30.0 PM

i Looking southeast, above horizon.
88 No eclipse in progress.
i# The Sun is down,

+ 29°48°
+137°52°

window, and you can use the scroll bar to
move throughitifitislonger than the window.
Click the OK button to dismiss the
information.

Chronology

Calenders and Astronomical Dates
Beware the Ides of March.
from Shakespeare’s Julius Caesar

Sky Travel allows you to go backward or for-
ward in time about 10,000 years. However, in
checking astronomical eventsin the past, you'll
need to be sure that the proper calendar date
is used — often no easy task.

The calendar of western civilization dates back
to 753 BC, the mythical date for the founding
of Rome. For many centuries, the Romans




dated events by counting from this date and
designated the years ab urbe condita (AUC),
which means “since the founding of city.” The
Roman year originally had only ten months
and began in the spring with the month of
March. We still have a reminder of this in the
names of the months September, October,
November, and December, meaning the
seventh, eighth, ninth, and tenth months,
respectively. Later on, the Romans added two
more months, January and February, at the
beginning of the year.

When the early calendar got too much out of
step with the seasons, the Romans occasionally
added an extra month. These adjustments,
made under the jurisdiction of the priests,
were often arbitrary and weren’t always co-
ordinated within different parts of the Roman
Empire. Understandably, this became increas-
ingly intolerable to the historians, scribes, and
tax collectors, not to mention the taxpayers.

Julius Caesar introduced the Julian calendar,
which was a major improvement, based on a
solar year of 365 1/4 days as determined by the
Egyptians (a year is actually 365.2422 days
long). This calendar has three years of 365
days and a fourth year (or leap year) of 366
days. Leap years then, as now, were those
evenly divisible by four. The Julian calendar
was put into effect on January 1,45 BC. In
order to offset errors accumulated before-
hand, corrections were made all at once in the
year 46 BC, which was made 445 days long and
is generally referred to as the “Year of
Confusion”!

The Gregorian calendar, the one currently in
use, was formally introduced by Pope Gregory
X1, in 1582 AD. His main interestin an
improved calendar was to ensure the proper
timing of the holy days of Easter. The Julian

calendar year was slightly too long. The
Gregorian calendar corrected the error by
requiring that only those years ending in
hundreds that were evenly divisible by 400
(such as 1600) and all other years evenly
divisible by four be leap years (366 days).
Other years ending in hundreds (such as 1700)
would remain normal years (365 days). Errors
which had accumulated since the establish-
ment of the Julian calendar were again
adjusted all at once by eliminating ten days in
the year 1582: October 4 was followed immedi-
ately by October 15.

The Gregorian calendar was not universally
adopted at the time. For example, England
and the American colonies didn’t adopt the
calendar until 17752 AD, at which time 11 days
had to be eliminated: September 2 was im-
mediately followed that year by September 14.
One well-known historical consequence is
the discrepancy in George Washington’s
birthday. According to the Gregorian calendar
in use today, he was born on February 22, 1732
AD, but the calendar in use at his birth showed
February 11. Russia didn’t change to the
Gregorian calendar until the Bolshevik
Revolution (1917 AD), at which time 13 days
had to be eliminated.

After the French Revolution, France’s National
Convention in 1795 AD legislated a “new”
calendar, based in part on the decimal system.
The year started in the fall at the autumnal
equinox and consisted of 12 months, each with
30 days. A month was divided into three ten-
day weeks, each day having 10 hours, each
hour 100 minutes, and each minute 100
seconds. To correct for the fact that a year is
longer than 360 days, five or six specially
named extra days were added at the end of
each year. Actually, this revolutionary calendar




was not new at all, but a rediscovery of an
ancient calendar used in Egypt as early as 3000
BC. However, no one liked the ten-day week,
the attempt failed, and the law was repealed in
1805 AD.

Astronomical calculations are based on “Julian
day numbers,” which have nothing to do with
the Julian calendar. The system was created in
1583 AD by the French chronologist and math-
ematician J.J. Scaliger, who named hisinvention
after his father. The Julian day number system
begins at Greenwich noon (GMT) on January
1,4713 BC; a Julian number is simply the
number of the day in a continuous count since
that date. Dates before 4713 BC are counted as
negative numbers. The Julian day number
system has three simple advantages: first,
differences in days can be determined by
simple subtraction; second, the week can be
determined by dividing the Julian day number
by seven, and then using the remainder to
define the day of the week (0=Monday, 1=
Tuesday, and so on); and third, it provides an
unambiguous reference standard for synchro-
nizing dates among the multitude of ancient
calendars.

For example, set the date to:
Wed Feb 29,1984 AD

Because 1984 is evenly divisible by four, it’s a
leap year and February 29 exists. Now change
the year to 1985; the date changes to February
28, since there is no February 29 in a non-leap
year. Now change the year to 1900 AD and try
to set the date to February 29; Sky Travel won’t
let you. Although 1900 is evenly divisible by
four, it ends in hundreds and is not evenly
divisible by 400; by the Gregorian calendar
convention, such years are not leap years. In
contrast, the year 2000 AD is evenly divisible
by 400; hence, it’s a leap year and February 29
exists.

An example of how Sky Travel can be used to
determine historical dates with certainty is the
rare planetary occultation of Jupiter by Mars
presented earlier. The German astronomer
Johannes Kepler reported that the event oc-
curred on January 9, 1591 AD; yet, if you try to
repeat the example on that date, you’ll see that
no occultation occurred. However, on January
19, 1591 AD, the date given in the example,
there was indeed an occultation. The explana-
tion is unquestionably that in 1591 — only nine
years after Pope Gregory had introduced his
calendar reform — Johannes Kepler in
Germany was still using the Julian calendar.

The Star of Bethlehem
Now, when Jesus was born in Bethlehem of
Judaea in the days of Herod the King, behold,
there came wise men from the east to
Jerusalem, ... and, lo, the star, which they saw
in the east, went before them, till it came and
stood over where the young child was.
Matthew 2: 1,9
The Julian calendar was used for many
centuries with the year count beginning at the
founding of Rome (AUC). However, in the 6th
century AD (by our present calendar), the
monk and scholar Exiguus suggested that the
count start instead at the birth of Christ, which
he calculated to have occurred in the year 754
AUC. The proposal was accepted only
gradually. In the 9th century, Charlemagne
ordered this change in the calendar within his
empire. Even so, the custom of counting the
years from the birth of Christ did not become
common practice in Europe until the 11th
century AD.
There is considerable uncertainty as to the
accuracy of Exiguus’s calculations. Although
Christmas is celebrated on December 25 by
convention, both the day and year of Christ’s




birth are uncertain. For example, based on
what are believed to be reliable historical
sources, Herod the Great died in 4 BC; both
the accounts in Matthew and Luke state that
Christ was born during Herod'’s reign.

Because astronomical events have often
proven to be a means of accurately dating
historical events, the brief description of the
“star of Bethlehem” in Matthew might provide
a valuable clue. Many attempts were made for
centuries to identify the nature of the “star”
that brought the three Magi to Bethlehem. It
has been suggested, for example, that the
“star” might have been a supernova, but such
an event would most likely have been
observed and recorded elsewhere; besides,
no supernova remnant from that time has ever
been found.

Another suggestion was thatit might have been
a comet. For example, the early Renaissance
painter Giotto depicted the star as a cometin a
well-known 1300 AD fresco of the nativity
scene in the Arena Chapel in Padua, Italy.
Indeed, later studies have shown that Halley’s
Comet did appear during October in the year
12 BC.

However, according to the account in Luke
2:1-7, Joseph and Mary traveled to Bethlehem
because Caesar Augustus had issued a census
order, since dated at 8 BC. The apparition of
the comet in 12 BC, therefore, is too early to
be the plausible explanation.

Itis considered more likely that the “star” was
an unusual planetary alignment. A very close
conjunction of the planets Venus and Jupiter
occurred on June 17.2 BC (Sinnot: 1986).
However, conjunctions of these two planets
are frequent, and they are of very short
duration. Therefore, it’s doubtful that this
even would have been unusual enough for

the magi to undertake the long and arduous
journey to Jerusalem (Burton: 1977).

A triple conjunction of Jupiter and Saturn
occurred in 7 BC, with the two planets being
close from May all through December.
Johannes Kepler suggested in the seventeenth
century that this might have been the “star” of
Bethlehem.

The alignment took place in the constellation
Pisces (the Fish) at the time when the vernal
equinox was moving from the sign of Aries
into the sign of Pisces. This may well have had
a special meaning to magi from the
Mesopotamian region who were well-versed
in Babylonian astrology. Assuming that these
conjectures are correct, September 15 has
been suggested as the most probable date for
the birth of Christ (Hughes: 1979).

Sky Travel allows you to observe the alignment
of Jupiter and Saturn on that night nearly 2000
years ago.

Select World Map... fromthe Options
menu, and go to Bethlehem:

3R2°R9'N Latitude
34° 1'E Longitude
Time Zone -3

Set the date and time:

Tue Sep 15,7 BC

11:55.0 PM
Set the view angle to 72°. Now find Saturn.
You are now looking at the midnight sky over
Bethlehem; Saturn and Jupiter are very close
to each other. Now, turn off the
Constellation Names and Planet
Symbols options.
Sky Travel has now re-created the suggested
“star of Bethlehem” as it may have appeared
to the Magi and the shepherds on the night
Christ was born.
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History and Archaeology

Solar Eclipses In Antiquity
WARNING! Never look directly at the Sun,
even during a total eclipse!

In ancient times, total solar eclipses, which
turned day into night, were believed to be
frightening signs of the displeasure of the
gods. In many instances, primitive responses
to eclipses influenced human history.

Eclipses are important to historians for another
reason. Because they were widely considered
to be warnings of great misfortunes and
calamities, they were often recorded if they
had preceded major historical events. Since
present-day calculations can determine the
precise date of an eclipse for a given location,
such records have proven extremely valuable
for synchronizing early calendars and cor-
relating the histories of ancient societies.

The Roman statesman Cicero has written about
asolar eclipse that occurred on June 21, 400
BC. This eclipse attracted special attention
since it occurred near Rome a few minutes
after sunset and was very nearly total. The
sudden, complete darkening of the twilight sky
followed by the reappearance of twilight was
described by the poet Ennius as “on the nones
of June, the Sun was covered by the Moon and
night.”” This particular event is an example of
an eclipse that has helped histories solve some
problems with the very cumbersome early
Roman calendar.

With Sky Travel, you can re-create this famous
solar eclipse from an observation point near
Rome:
42° 0'N Latitude

14° 0'E Longitude
Time Zone -1
Sat Jun 21,400 BC

6:30.0 PM

Note: When adjusting the date in BC,
the arrows appear to work back-
ward. Actually, the up-arrow still
adjusts the values forward in time,
but since the period is set for BC,
the years count down toward the
birth of Christ, rather than up
away from it.

Find the Sun, set the clock rateto 16x, and
watch the sunset until about 8:00 PM.

Lunar Eclipses in Antiquity

Although the loss of the Moon’s light was less
frightening to people in antiquity than the loss
of the Sun’s light, a lunar eclipse was neverthe-
less considered an important omen.

The Greek historian Thucydides reported on a
famous lunar eclipse during the Peloponnesian
war. The eclipse occurred on August 27, 413
BC, the day the Athenian commanders had
planned to leave Syracuse. The Eclipse so
frightened the Athenian soldiers and sailors
that, on the advice of the astrologer-priests,
the departure was delayed 27 days. This delay
gave the people of Syracuse the opportunity
to regroup, and they destroyed or captured
everyone in the Athenian force.

Cicero and the Roman historian Livy have both
written about a lunar eclipse that occurred on
June 21,168 BC, during a war between Rome
and Macedonia. The Roman soothsayers
astutely construed the eclipse as a sign that the
reign of the Macedonian king was nearing its
end. The eclipse — and the priests — were
thus given credit for having contributed to the
Roman victory at the famous battle of Pydna,
which marked the end of the Macedonian
Empire founded by Alexander the Great
(Banks: 1973).

To see these historical lunar eclipses for
yourself, begin by journeying to Syracuse,
Sicily:




37°30'N Latitude
15°00'E Longitude
Time Zone -1

Mon Augl7,413 BC
7:45.0 PM

Stop the clock, find the Moon, and then turn

r

For the second example, stop the clock, and
then go to the ancient city of Pydna near Mt.
Olympus in Greece:

40°3'N Latitude

RR°6'E Longitude

Time Zone -1

&€ File Edit Options UView Find Clock R

the Track Object command on. Adjust
your view angle to 36°, and then set the
clock rate to 32x. The gray disk of Earth’s
shadow will become visible as the Moon enters
into it. The eclipse becomes total just before
9:00 PM and is over by about 11:25 PM.

Mon Aug 27, 413 BC
8:28.7 PM

Looking southeast, above horizon.
Lunar eclipse in progress.
The Sun is down. R

Latitude
Longitude

Time Zone

Elevation
Azimuth +106°47°

Right Ascension 23h35m 8
Declination - 10°22°

Tue Jun 21,168 BC

7:00.0 PM
Leave the Track Object (which will read
Track Moon)command on. Set the clock
rate to 32x, and watch the Moon rise, totally
eclipsed. By about 9:40 PM the eclipse is over.




The Great Pyramid at Giza

The Great Pyramid at Giza, near Cairo, was
built during the reign of Cheops (Khufu), a
pharaoh of the 4th dynasty. The dimensions of
this, the greatest of the pyramids, are truly
impressive: the base is a square measuring 756
feet on each side and covers more than 13
acres; the original height was 482 feet. Even
more impressive is the precision of this large
monument: the maximum deviation from a
true square is less than eight inches, and the
base is aligned in the four cardinal directions,
north, south, east, and west, with a maximum
deviation of less than 1/10 . This is testimony to
the skill of the early Egyptians as master
builders and surveyors.

The pyramid is a solid building containing
more than two million limestone blocks, each
weighing an average of two and one-half tons.
Originally faced with smooth, well-fitted
white limestone, the pyramid was capped with
gold. The Greek historian Herodotus, who
visited Giza in the 5th century BC, reported
that Cheops, during his 50-year reign,
exchanged 100,000 men every three months to
toil at the construction site.

The interior of the pyramid is accessible
through a single entrance, originally covered,
on the north face about 55 feet above ground
level. From here, a narrow corridor descends
ata 26° angle for 355 feet to an unfinished sub-
terranean chamber. About 100 feet from the
entrance, another corridor, originally blocked
off, ascends at a 26° slope from the ceiling of
the descending corridor. The ascending
corridor ends in a long, tall, narrow chamber
called the Great Gallery. The gallery is con-
nected to an upper burial chamber, the King’s
Chamber, and through a separate corridor
(also originally blocked off) to a lower burial
chamber, the Queen’s Chamber. The purpose

of the complicated network of corridors was
no doubt to mislead potential grave robbers.

Soulh +— ——= North

Top View

South 445 3 North

Cross Section

Of special interest are two narrow (nine-inch
square), precisely aligned shafts, one leading
from the upper end of the gallery and ending
on the northern face of the pyramid, the other
leading from the King’s Chamber and ending
on the southern face. The purpose of these
shafts have been the subject of speculation for
centuries. An early suggestion that they were
intended for ventilation is implausible: the
construction of these shafts at precise angles
through many courses of limestone blocks
must have been such an arduous task that a
much more commanding reason must be
sought. Considering the importance of
celestial mythology to the ancient Egyptians,
it’s much more likely that the astrologer-priests
oriented the shafts toward carefully selected
regions of the sky.




Early estimates placed the 4th dynasty, the
period of the “Great Pyramid Kings,” at about
4000-3000 BC. However, at that time, the
northern shaft would have pointed toward a
segment of the sky without any bright stars. In
contrast, from 3000-2500 BC, the bright star
Thubanin the constellation Draco was perfectly
aligned with the northern shaft. Based on this
and other evidence, the time of the building
of Cheops’ pyramid is now believed to have
been about 2800-2600 BC. The question then
is what did the southern shaft point toward at
that time? Recent studies show that only three
bright stars qualify — the three stars in what
we now call Orion’s belt (Trimble: 1964).

It’s not likely that the shafts were intended for
astronomical observation. First, the shafts
were originally covered by the facing stones
on the pyramid. Second, a slight bend at both
ends of the shafts, presumably designed to
prevent accumulation of sand and debris,
would have prevented direct sighting. It’s
therefore more likely that the purpose was a
religious one.

In ancient Egypt, the circumpolar stars, which
neither set nor rose, were called
“imperishable” stars and represented immortal
gods. The pharaoh’s soul was believed to
ascend to these eternal stars to take its place
among the gods in the sky. Thuban, then the
polestar, would have been the ultimate eternal
star. The stars of Orion, in turn, were repre-
sentative of Osiris, the Egyptian god of transfor-
mation and resurrection. The shafts in the
pyramid were therefore most likely intended
as passageways for Cheops’ soul toward its
ultimate destination in the sky. The Pyramid
Kings of the 4th dynasty left no written records
and no pictorial descriptions on the walls of
their tombs. Yet, in the precise alignment of
their pyramids, they revealed insights into

astronomy that have allowed later generations
to determine the age of these pyramids.

With Sky Travel, you can re-create the ancient
sky over Giza as it appeared at the time of the
construction of Cheops’ pyramid. By setting
the elevation and azimuth of the cursor to cor-
respond to those of the northern and southern
shafts, you can see the transits of Thuban and
the belt stars of Orion, respectively, as the
pharaoh’s astrologer-priests planned it more
than 4500 years ago. Stop the clock, and begin
at Giza:

29°59'N Latitude
31°00'E Longitude
Time Zone -2

FriJdan 1,700 BC
8:00.0 PM

Turn off all tracking options, and make sure
thatthe Constellation Names,
Constellation Lines, and Celestial
Globe Lines options are activated. Set the
view angleto 7R°. Select North from the
View menu. Now use the Constellation
command in the Find menu to locate the
constellation Ursa Minor ( UMi). Because
of Earth’s precession, Polaris is no longer the
polestar. The view in the center of the sky
display now corresponds to the view through
the northern shaft of the pyramid at the time
of its construction. Place the cursor over the
star in the center of the screen and verify that
the star is Thuban. Now set the clock rate to
64x, and watch the stars rotate around
Thuban as they did at the time of Cheops.
Now change the setting to show the original
view through the southern shaft. Stop the
clock; select South from the View menu.
Drag the cursor as close as possible to an
elevation of 44°30’, watching the display in the
position window. Next, set the clock rate to




64x, and watch the belt stars in Orion pass
through the Mark (at about 8:25 PM).

Cheops’ pyramid was admired even in antiquity
as one of the seven wonders of the world; in
fact, it’s the only one still standing. However,
in terms of the its principal function, namely
to guarantee the pharaoh a peaceful resting
place surrounded by his vestiges of power and
wealth and protected from grave robbers, it
was a monumental failure. Today, none of the
pharaoh’s treasures remain, and even the
mummy of Cheops himself vanished long ago.

The Stone Lion of Numrud Dagh

In the 1st century BC, Antioch | of Commagene
(Kummuhu) was as concerned with preserving
his bodily remains and worldly goods as
Cheops had been. He may have been more
successful, however, since it appears that to
this day, nobody has uncovered his burial
chamber. Commagene, now desolate and
barren, in ancient times was a fertile land
between the Greek and Roman empires to
the west and the Mesopotamian and Parthian
empires to the east.

A century ago, German and Turkish archaeolo-
gists investigated an open-air pantheon of
colossal statutes on top of the Nimrud Dagh
(Mt. Nimrod), a 7000-foot mountain south of
the Anti-Taurus mountain chain in Turkey and
just north of present-day Syria. The statues
were between 25 and 29 feet tall and stood on
20-foot-high platforms on two terraces, one
facing east and the other west. The eastern
terrace also contained a fire alter for religious
ceremonies. The stone statues were magnifi-
cently carved and represented an intriguing
blend of Greek and Persian gods, as well as the
king himself. Between the terraces was a
150-foot-high stone mound believed to contain
the remains of King Antioch (Goell: 1961).

Of particular interest was a large stone relief of
a lion showing 3 planets, a crescent Moon, and
19 stars on and around the lion’s body. A
sketch of the stone lion is shown below:

Mars

Mercury
Jupiter

- Reguius

1= Croscent Moon

Greek inscriptions identify the three large stars
above the lion as the planets Mars, Mercury,
and Jupiter. The star pattern is recognizable as
the constellation Leo. The prominent star on
the lion’s chest is no doubt Regulus, also
known as Cor Leonis, or the heart of the lion.
The star nearest the tail must be Denebola,
which means “tail of the lion.” The angles in
the constellation are a bit distorted, but this
may be ascribed to artistic license on the part
of the unknown sculptor.

This stone lion is the first known Greek
horoscope, and the unusual configuration of
the Moon, planets and stars has been ex-
tensively studied in an attempt to determine
the exact date represented by the horoscope.
These studies show that the only dates on
which a crescent Moon and three planets were
observable in the sign of leo during the life of
King Antioch were July 6-7, 62 BC. These dates
are in agreement with the arrival in the region
of the Roman consul Pompeius after he had
defeated Mithradates VI, finally consolidating
the Roman protectorates in Asia Minor. The
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kingdom of Commagene was a buffer state
between the Roman and Parthian empires,
and it has been suggested that King Antioch
may have shown his gratitude for the defeat of
the treacherous Mithradates by erecting this
temple and perhaps even by counting his own
reign from this date (Neugebauer and Van
Hoesen: 1959).
With Sky Travel, you can compare the appear-
ance of the sky over Commagene on the above
dates with the planetary configuration and
crescent Moon depicted on the stone lion.
First, a quick trip to Samosata, ancient capital
of Commagene:
37°6'N Latitude
38°7'E Longitude
Time Zone -3
Wed Jul 7,62 BC

8:056.0 PM

(r

Turn off the Celestial Globe Lines
option, and set the view angle to 36°. Next,
select Leo fromthe Constellation. ..
command in the Find menu. Note that the
three planets and the crescent Moon are
indeed clustered in the constellation Leo.
Actually, the only time they were all visible was
shortly after sunset, and then only for a brief
period. If you check the previous day, you'll
see that the Moon, although within the con-
stellation Leo, had notactually crossed into the
sign (or house) of Leo, the beginning of which
is marked by its symbol. Of the two days, July
7 appears to be the better fit for the horoscope.

&€ File C(dit Options Diew Find Clock

WeddJul 7, 628BC
8:05.0 PM

ooking west, above horizon.
i No eclipse in progress.
he Sun is setting.

Elevation
Azimuth

Right Ascension
Declination




Navigation

The art of navigating by the Sun and stars was
developed by mariners in ancient times. The
earliest primitive form of navigation consisted
merely of determining the “bearing,” or the
direction in which you were sailing.

In order to know your position, it’s necessary
to determine both your latitude and longitude.
Latitude can be determined solely from celestial
observations; longitude requires knowledge
of both local time and the time at some
reference longitude, i.e., the time difference
from a known longitude. Although it’s always
possible to determine local time, it wasn’t until
the invention of a reliable portable chrono-
meter by the British clock maker John Harrison
in 1735 AD that it became possible to know a
reference time aboard ships. The standard
reference time and longitude was and still is
that of Greenwich.

Latitude from Polaris

Atany point P on the Northern Hemisphere,
the latitude equals the elevation above the
horizon of the North Pole (see the illustration
above ). Since stars are so far away that
sightings are parallel no matter where on Earth
they are made, the north-south line of Earth
and the sighting line from P are parallel. It
follows that the angle of P’s latitude equals the
angle of elevation of the North Pole as sighted
from P: (see the illustration above).

Since Polaris is within 1° of the North Pole, you
can get an immediate, approximate reading of
your latitude simply by measuring the elevation
of the polestar, as long as you're in the
Northern Hemisphere.

Imagine you’re a merit-badge counselor in
astronomy for the Boy Scouts. Your young
scouts want to know whether astronomy “can
be used for anything,” so you give them a
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problem to figure out. You tell them they’re
on a small boat in the Caribbean. There has
been a storm, their two-way radio doesn’t
work, and they’re lost. However, they have a
small sextant, a wristwatch, a small transistor
radio, and a map. The sea is now calm, and the
boat is dead in the water with no current. Just
before dawn, a break in the clouds allows them
to read the elevation of Polaris as 15.5°.
Around noon, they sight the Sun at its highest
elevation and find that their watch shows 12:15
PM. Shortly afterward, they hear a radio
broadcast from Miami stating that it’s 12:30 PM
(EST). When they check their wristwatch, it
shows 12:37 PM. Where are they?

First, their latitude is approximately the same
as the elevation of Polaris, (15.5°N). Second
the broadcast tells them that their watch is
seven minutes fast, meaning that the Sun was
at its zenith at their location at 12:08 PM (EST).
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Third, since eastern standard time is zone 5,
the Sun would be at its zenith at 12:00 noon
(EST) in the middle of time zone 5, which is
five times 15° or 75° west of Greenwich (5 for
the number of time zones away from time
zone 0 and 15° per time zone). Thus the boys
conclude that they are eight minutes or 2° (8 x
15 /7 60° = 2°) farther west than the middle of
time zone 5. Accordingly, their longitude must
be 75° + 2° or 77°W. Looking at their map, the
boys see that they’re about 2.5 (150 nautical
miles) directly south of Kingston, Jamaica. By
setting a course due north, they cannot miss
this large island, where they’ll be able to get
their equipment repaired.

Using Sky Travel, you can go to the World Map,
position the Mark at the boys’ latitude and
longitude, return to the Primary Windows,
and show the boys that the elevation of polaris
and the local time of noon were as they
reported!

Positional Navigation

You can determine your position on Earth in
terms of both degrees and distance. Since the
circumference of Earth is 40,000 kilometers
along any great circle (the equator, for
example), 1° of arc corresponds to 111 km (69
miles or 60 nautical miles; 40,000 km/360° 111
km/1°). One minute of arcis 1.9 km (1.2 miles
or 1 nautical mile) and one second of arc is 31
meters (116 feet). If, for instance, you want to
know your location to within 200 meters or
1710 of a mile, your position in terms of
degrees must be determined to within 1/10 of
a minute of arc. For this reason, a number of
corrections are required to ensure that obser-
vations of celestial objects are sufficiently
accurate.

Consider also the accuracy needed in a
chronometer for determining longitude. In

1714, the British Government posted an award
of 20,000 pounds for anyone who could design
a clock that could be used to determine a
ship’s longitude within 30 miless after a
six-week voyage. This translates into an
accuracy of better than three seconds per day
— much better than even a pendulum clock
on land was able to do at that time. John
Harrison won the award, and by the end of the
18th century, chronometers were in common
use aboard ships.

After the invention of the radio by Marconi in
1920, it became very easy to know the
Greenwich time anywhere on Earth, so
longitude became as simple to determine as
latitude. Today, pulsed radio and radar signals
from Earth stations and satellites, combined
with on-boat computers ,have speeded up
navigation computations to match the needs
of jet airplanes and spacecraft. Still, in case of
equipment or power failures, the chronometer
method is a stand-by technique, especially on
small ocean-going craft. Navigation by the
stars is, of course, a special subject in the case
of space exploration.

Sky Travel cannot cover the actual techniques
used in nautical and air navigation. Due to the
accuracy of measurement required, a number
of corrections must be made to the direct
readings (for example, for altitude over the
horizon or for refraction by air). Nevertheless,
Sky Travel can replace a Nautical Almanac for
instructional purposes, since the program can
calculate the position of the Sun, the Moon,
and the navigational stars at any time from any
location on Earth. This means you can use the
program as a self-contained system for training,
without the need for sextants, astronomical
tables, or even clear weather!




Space Exploration

... itwould be surprising if life were not
abundant in the galaxy. Our problem is to
find it.

George O. Abell

In July 1969 AD, American astronauts landed
on the Moon. They were the first human
beings ever to set foot on a celestial body
other than Earth. The astronauts left a plaque
with a message in English, with the reasonable
expectation that other human expeditions to
the Moon will occur before English — and
perhaps humankind — becomes extinct.
Toward the end of 1973 AD, the spacecraft
Pioneer 10 passed Jupiter on its way toward the
constellations Taurus and Orion, the first
human-made object to leave our solar system.
This mission also carried a plaque, but since
other intelligent beings in the universe would
be unfamiliar with any human language, the
message was written in the language of science:

In order to introduce ourselves to extra-
terrestrials who may have developed very
differently from the way we have, male and
female humans are shown to the same scale as
a drawing of the spacecraft. The symbol at the
top of the plaque refers to hydrogen, the most
abundant element in the universe. To identify
the launch site, Pioneer 10 is shown leaving
Earth and passing out of our Solar System
between Saturn and Jupiter. In order to allow
a decoding of the time of the launching, a
diagram shows the directions to 14 pulsars as
presently seen from our solar system. Ina
sense, this plaque is a 20th century counterpart
of the stone lion of Nimrud Dagh.

This space experiment has been compared to
throwing a bottle with a note into the sea.
However, such a comparison is charitable: the
ocean of the universe is vast, and even though
Pioneer 10 travels at seven miles per second, it
will not reach a potential planetary system for
ten billion years (Sagan: 1980)!

The space program has encouraged laypersons,
scientists, and science fiction writers alike to
speculate on future human exploration in
space and on the possibility of finding intelli-
gentlife-forms somewhere else in the universe.
Sky Travel, through its Information. ..
command, provides general information about
all the celestial bodies and galaxies visible on
your screen, as well as their distances if known.
With thisinformation, you can appreciate both
the possibilities and the limitations of inter-
planetary and interstellar exploration and
make your own judgments regarding reports
you will see or hear in the news media in

the future.




Astronautics

The space program has resulted in a general
realization of just how unique Earth really is,
and how inhospitable the rest of even our own
solar system is. This doesn’t mean that coloni-
zation of space is impossible, but it does mean
that it will be difficult — and probably quite
some time in coming. Aside from artificial
space stations, the most likely bases for space
colonies in our solar system are the Moon and
perhaps the asteroids between Mars and
Jupiter. These asteroids are relatively small,
solid bodies ranging from about 1 to 500 miles
in diameter; their advantage is that they are
already in orbit. Some day such space stations
might well serve as bases for deeper space
probes.

The following procedure details the nature
(size, temperature, and composition) of the
Moon and the planets and lists the distances
within our solar system.

Use the commands in the Find menuto
locate each planet and the Moon. As you do,
use the Information ... commandon
each one. Since the fastest existing spacecraft
travels at a speed of no more than about
1/10,000 the speed of light, you can calculate
present travel times from the distances given.
For example, to calculate travel time to a
planet, multiply the number of light-minutes
by 10,000 and convert the minutes to days,
months, and years. For human space travel
outside the solar system, the problems are
literally astronomical. The distance to the
nearest bright star (Rigil Kentaurus) is 4.3
light-years, which corresponds to a travel time
of 43,000 years!

Of course, it’s possible that the speed of future
spacecraft may be increased dramatically. It’s
also possible that astronauts could be brought

to a state of hibernation to increase their life
spans or that later generations born and raised
on board might eventually make it to distant
places in the universe. Nevertheless, even if
they do, thisis not exploration in the sense that
Earth was explored, nor the type of exploration
that may be possible within our solar system
itself: there would be no return tickets for the
astronauts! Should they or their descendants
ever return to Earth, it would be to a different
place. If humankind were still to exist, the
difference might be even greater than that
between the Stone Age and our own age.

To develop an appreciation of the enormity of
the universe and the distances even to the
closest stars and galaxies outside our solar
system, use the star and constellation tables in
the back of this manual. Forexample, compare
the distance from Earth to Sirius in Canis Major
to the distance from Earth to Deneb in Cygnus.
To locate the selected stars and deep-sky
objects, use the Constellation. ..
command from the Find menu and select
the star’s corresponding constellation. Once
the constellation is centered in the Sky
Window, use the Information...
command on the star. If you don’t recognize
the star, rather than resorting to trial and error,
use the declination/right ascension values in
the star table and the same values in the
Position Window to place the Mark directly on
the star.

Sky Travel’s Deep Sky Objects command
lets you study the distant universe on your
Macintosh. Here are a few examples:

Our galaxy, the Milky Way, is 100,000
light-years across. Our Sun is about 30,000
light-years from the center of the galaxy. If
you look toward Sagittarius, you're looking in
the direction of the center of the Milky Way.




Set the World Map and the date and time as
follows:
0°0’N Latitude
77°0’W Longitude
Time Zone 5
FriJdun 14,1985 AD
12:00.0 AM

Fromthe Options menu turn on
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Take a look now at the Milky Way in the
direction of Orion and Canis Major. Fora
good view, you must go to the winter season.

Keep the above settings, but change the month
to December. Again look south with a view

Constellation Names, Constellation
Lines, and Deep Sky Objects. Set the
view angle to 72°, and select South from
the View menu for asouthern view. You
now have a typical summer night’s view with a
section of the Milky Way stretching diagonally
across the screen. Note the many star clusters
in this section.

Fri Jun 14, 1985 AD
12:00.0 AM

Looking south, above horizon.
No eclipse in progress.
# The Sun is down.

+ 31°19°
~-180° 0°

4 Right Ascension 17'23" 2 ||
i Declination - 58°40° |f

angle of 72°. Here you see a section of the
Milky Way that covers the whole left half of
your screen. Note particularly M42, the Great
Nebula below the belt stars in Orion.
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The closest galaxies to the Milky Way are the
Small and the Large Magellanic Clouds, named
after Ferdinand Magellan, the Portuguese
explorer and discoverer of the Magellan Strait,
who observed these “clouds” in the southern
Sky. Satellite galaxies of the Milky Way, the
Magellanic Clouds are 160,000 to 180,000 light
years away. In order to observe them, you’ll
need to go to the Southern Hemisphere.

Leave the date and time (Dec 14, 1985,
12:00.0 AM) from the previous example, but
change the World Map settings to the
following:

Har

Clock

Sat Dec 14, 1985 AD
12:00.0 AM

Looking south, above horizon.
No eclipse in progress.
The Sun is down.

Latitude i
Longitude 77° 0wl
Time Zone 5 i
+ 63°39° ||
+174°10°
5h34m,

- 26°11° |

Elevation
Azimuth

Right Ascension
Declination

24°0’'S Latitude

49° 0'W Longitude
Time Zone 3

Set your view angle to 7R2°, then select
Constellation. .. fromthe Find menu.
The easiest way to locate the Large Magellanic
Cloud is to find the constellation Dorado
(Dor). The Large Magellanic Cloud is
indicated by the outline and several star
clusters within the nebulosity. The Small
Magellanic Cloud is nearby in the constellation
Hydrus ( Hys).
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Earlier, you observed the Andromeda Galaxy,
the most distant object in the sky that can still
be seen with the naked eye. This galaxy is 2.2
million light-years away. The known universe
is 40 billion light-years across (Gore: 1983).

Extraterrestrial Life
No signs of intelligent life, Scotty. Beam us up.
Kirk out!

Captain James Kirk, from the television series

Star Trek

The question of the possible existence of life
beyond Earth is really a question on two levels.
First, is there any form of life? Second, are
there any intelligent life-forms? As to the first
question, the Viking spacecraft’s trip to Mars
tried to determine whether the Martian soil
contained any form of living organisms with

Sat Dec 14, 1985 AD
2:00.0 AM

Looking south, above horizon.
No eclipse in progress.
The Sun is down.

+ 30°13° [
+176°12° | f

oh gm.1 |/

which the addition of water and nutrients
would show a typical biological reaction.
Unfortunately, the results were inconclusive:
the soil did respond, but in such a manner that
chemical reactions alone might explain the
observations. Thus, there is still no proof of
life, even in a primitive form, beyond Earth.

The conditions that enable life, especially
higher life-forms, to exist appear to occur very
rarely in the universe. On the other hand, the
universe is incredibly huge. In trying to
estimate the probability that intelligent life-
forms exist somewhere in the universe, we
have to multiply a very small number by a very
large one, both of which we have little basis
for estimating. The result of such a calculation
is basically a guess.




If we ask whether any advanced extraterrestrial
beings might exist close enough to make pos-
sible some form of contact, such as the
reception of radio signals, the answer is a
definite “maybe.” But the contact would
hardly be a traditional conversation: by the
time the answer got back, the “civilization”
might well have ceased to exist! Certainly, the
civilization on Earth, assuming that one still
existed, would be very different from the one
that sent the signals.

When a source of extremely regular radio
pulses from deep space was observed for the
first time in 1967 AD, the discoverers initially
referred to the deep-sky object as LGM1

(LGM standing for “little green men”). Similar
objects have since been detected and are now
called pulsars. The types of radio signals
emitted have been shown to be those expected
from a rapidly rotating neutron star.

We may not be alone, but do not seem to have
any close neighbors!

TECHNICAL NOTES

The technical details that follow are of
particular interest to astronomers and
advanced students.

Stellar Positions

A 2000 AD-epoch star catalog is used as the
basis for all stellar positions. Calculations for
other epochs take into account Earth’s preces-
sion but not the proper motion of the stars.
With the exception of a few of the closest stars
which have large proper motions, stellar
positions are accurate to within one minute of

arcover the time span from 9999 BC to 9999 AD.

Planetary Positions

The planetary ephemerides used in the
program are based on the method of T. Van
Flandern and K.F. Pulkkinen The Astrophysical
Journal, Supplement Series, Vol. 41, Nov. 1979:
391-411). Planetary perturbation effects are
included. For the period 1700 AD-2300 AD,
planetary position calculations are accurate to
within a few minutes of arc. An exception is
Pluto, whose orbit is not known accurately
enough for position calculations better than

about 15 minutes of arc. The utility of the
planetary ephemerides has been considerably
extended into the past by correcting for the
difference between universal time (related to
Earth’s rotation) and ephemeris time (related
to an absolute atomic clock standard). Calcula-
tions for the distant future are less reliable due
to the lack of an accurate physical model for
the long-term variations in the rate of rotation
of Earth.

Solar and Lunar Positions

In addition to the planetary perturbations, this
program allows for the long-term decelerations
of the orbital motions of Earth and the Moon
(due to tidal effects). For modern times
(1900-2000 AD), the solar and lunar positions
are accurate to within one minute of arc. For
dates earlier than 1000 AD, time differences of
30 minutes to two hours may be expected due
to uncertainties in the difference between
ephemeris time and universal time. These
differences are the result of changes in the
distribution of mass on Earth (such as formation
and melting of ice caps, continental drifts, and




convection in the mantle) and may cause cor-
responding errors in lunar positions ranging
from 15 minutes of arc to 1°. In cases where
there’s suitable historical data to verify events,
the accuracy has been well within these limits.

Display Updates

When the Sky display is driven by the clock,
the positions of all celestial bodies are updated
automatically according to the following
schedule:

Update Intervals in minutes and seconds

Clock Rate Clock Time Real-Time
1x 0:48 0:48
2x 1:24 0:41
4x 2:18 0:34
8x 3:48 0:28
16x 5:36 0:21
32x 7:48 0:14
64x 8:24 0:08

Precession updates occur automatically
whenever the interval between a new
date/time setting and the previous one
exceeds 50 years. To calculate precession for a
given year, set the clock to a date at least fifty
years different from the one it is currently on,
then set it for the date you wish.

° °
Graphic Display
In order to achieve a pleasing display, the size
of the tokens used to represent the Sun and
the Moon is greatly exaggerated. Since the
token size is constant, the size exaggeration
factor for both the Sun and the Moon varies
with the view angle, as shown in the table
below:

View Angle  Size Factor
722 16x
36° 8x
18° 4x

92 2x

4.5° Ix

The 4.5° view angle shows the Sun and
Moon to scale. Use this setting for eclipses,
transits, and occultations.

Enlarged tokens are also used for the stars and
planets to give an impression of their
brightness. The pixel patterns are shown in
the following table:

<-2
-210 -1
-1t00
Oto1

1to2

2103
304
4105

The deep-sky objects are also represented by
enlarged tokens with pixel patterns as shown
on the opposite page.




Planetary Nebulae . - <

Diffuse Nebulae

Star Cluster within } & G
Nebulosity ”
Globular Star Cluster % ® *

Open Galactic Star Cluster %" aee g

Elliptical Galaxy (* o,

The Andromeda Galaxy (M31) has its own
token.

In addition to aesthetic considerations, over-
sized tokens were chosen to help the user
easily differentiate between the various
celestial objects shown on the monitor. Actual
angular sizes are greatly exaggerated by the
displays, so the tokens do not portray the
actual apparent sizes of the objects they
represent. Nor were they intended to; they're
meant solely as schematic aids for displaying
the various celestial objects and for showing
their positions.

Spiral Galaxy (Normal,
Barred, or Irregular)

Eclipses, Transits, and
Occultations

Oversized tokens and finite intervals of
position updating can lead to misinterpreta-
tion of certain displays unless the 4.5° view
angle is selected. When wider fields are used,
overlap of tokens doesn’t necessarily mean
thatan eventisin progress. In the special cases
of solar eclipses, the program overcomes the
difficulty by calculating eclipse graphics based
on actual angular sizes rather than on the dis-
played token sizes. When an eclipse actually
occurs, the program plots a token for the
partially eclipsed solar disk that has the correct
relative size of the obscuring dark disk of the
Moon. This allows the various phases of a solar
eclipse, from first contact through totality to
last contact, to be displayed as they would
appear in the sky.




TABLES

Latitudes and Longitudes

I: North American Cities

Name Lalitude  Longilude State/Country
Deg Min NS Deg Min EW
Albuquerque 35 05 N 106 38 W New Mexico, USA
Anchorage 61 10 N 149 53 W Alaska, USA
Atlanta 33 45 N B4 23 W Georgia, USA
Baltimore 39 17 N 76 37 W Maryland, USA
Bangor 44 49 N 68 47 W Maine, USA
Boise 43 37 N 116 13 W Idaho, USA
Boston 42 20 N 71 05 W Massachuselts, USA
Calgary 51 03 N 114 05 W Alberta, Canada
Chicago 41 59 N 87 38 W [lllinois, USA
Cincinnati 39 06 N 84 31 W Ohio, USA
Cleveland 41 30 N 81 41 W Ohio, USA
Dallas 32 47 N 96 48 W Texas, USA
Denver 39 45 N 105 00 W Colorado, USA
Des Moines 45 35 N 93 35 W lowa, USA
Detroit 42 20 N 83 03 W Michigan, USA
Edmonton 53 34 N 113 25 W Alberta, Canada
El Paso 31 45 N 106 29 W Texas, USA
Faitbanks 64 51 N 147 43 W Alaska, USA
Halifax 44 38 N 63 35 W Nova Scotia, Canada
Honolulu 21 19 N 157 52 W Hawaii, USA
Houston 29 46 N 95 22 W Texas, USA
Indianapolis 39 46 N 86 09 W Indiana, USA
Jacksonville 30 20 N 81 40 W Florida, USA
Kansas City 39 05 N 94 37 W Kansas/Missouri, USA
Las Vegas 36 11 N 115 08 W Nevada, USA
Los Angeles 34 00 N 118 15 W California, USA
Madison 43 04 N 89 22 W Wisconsin, USA
Mexico City 19 25 N 99 10 W Mexico; Capital
Miami 25 45 N 80 15 W Florida, USA
Milwaukee 43 02 N 87 55 W Wisconsin, USA
Minneapolis 45 00 N 93 15 W Minnesota, USA
Monlreal 45 31 N 73 34 W Quebec, Canada
New Orleans 30 00 N 90 03 W Lousiana, USA
New York 40 43 N 74 01 W New York, USA
Nome 64 30 N 165 30 W Alaska, USA
OklahomaCity 35 28 N 97 32 W Oklahoma, USA
Omaha 41 15 N 96 00 W Nebraska, USA
Ottawa 45 25 N 75 42 W Ontario, Canada; Capital
Philadelphia 40 00 N 75 10 W Pennsylvania, USA
Phoenix 33 30 N 112 03 W Arizona, USA
Piltsburgh 40 26 N 80 00 W Pennsylvania, USA
Quebec 46 50 N 71 15 W Quebec, Canada
SaltLakeCity 40 45 N 111 55 W Utah, USA
SanFrancisco 37 45 N 122 27 W Calilomia, USA
San Juan 18 29 N 66 08 W Puerto Rico, USA

Sealtle 47 36 N 122 20 W Washington, USA
St. John's 47 34 N 52 41 W Newloundland, Canada
St. Louis 38 40 N 90 15 W Missouri, USA
Toronto 43 39 N 79 23 W Ontario, Canada
Vancouver 49 13 N 123 06 W British Columbia, Canada
WashingtonD.C. 38 55 N 77 00 W USA,; Capital
Winnipeg 49 53 N 97 10 W Manitoba, Canada

II: Cities Outside NA Continent
Name Latitude  Longilude Country/Continent

Deg Min NS Deg Min EW
Accra 5 33 N 0 15 W Ghana, Alrica; Capital
Addis Ababa 9 03 N 38 42 E Ethiopia, Alrica; Capital
Algiers 3 50 N 3 00 E Algeria, Africa; Capital
Amsterdam 52 21 N 4 54 E Holland, Europe; Capital
Anadyr 64 55 N 176 05 E USSR, Asia
Ankara 39 55 N 32 50 E Turkey, Asia Minor; Capital
Asuncion 25 15 § 57 40 W Paraguay, S. America; Capital
Athens 38 00 N 23 44 E Greece, Europe; Capital
Baghdad 33 20 N 44 26 E Iraq, Middle East; Capital
Bangkok 13 44 N 100 30 E Thailand, Asia; Capital
Beirut 33 52 N 35 30 E Lebanon, Middle East; Capital
Belgrade 44 50 N 20 30 E Yugoslavia, Europe; Capital
Benghazi 32 07 N 20 05 E Libya, Africa
Berlin 52 32 N 13 25 E West Germany, Europe
Bern 46 57 N 7 26 E Swinzerland, Europe, Capital
Bogola 4 38 N 74 05 W Columbia, S. America; Capital
Bombay 18 5 N 72 51 E |India, Asia
Bonn 50 44 N 7 06 E West Germany, Europe; Capital
Brasilia 15 45 § 47 57 W Brazil, S. America; Capital
Brussels 50 50 N 4 21 E Belgium, Europe; Capital
Bucharest 4 25 N 26 07 E Romania, Europe; Capital
Budapest 47 30 N 19 03 E Hungary, Europe; Capital
Buenos Aires 34 40 S 58 30 W Argentina, S. America; Capital
Cairo 30 03 N 31 15 E Egypt, Alrica; Capital
Calcutta 22 30 N 88 20 E India, Asia
Cape Town 33 5 S 18 28 E South Alrica, Alrica
Caracas 10 35 N 66 56 W Venezuela, S. America; Capital
Casablanca 33 9N 7 35 W Moroceo, Alfrica
Colombo 6 55 N 79 52 E Ceylon-Sri Lanka, Asia; Capital
Copenhagen 55 43 N 12 34 E Denmark, Europe; Capital
Dacca 23 &2 N 90 22 E Bangladesh, Asia; Capital
Dakar 14 38 N 17 27 W Senegal, Africa; Capital
Dublin 53 20 N 6 15 W lreland, Europe; Capital
Godthaab 64 15 N 51 35 W Greenland
Hanoi 21 01 N 105 52 E N.Vietnam, Asia; Capital
Havana 23 07 N 82 25 W Cuba, Caribbean; Capital
Helsinki 60 08 N 25 00 E Finland, Europe; Capital
Hiroshima 34 23 N 132 27 E Japan, Asia
Hong Kong 22 15 N 114 11 E China, Asia
Istanbul 41 02 N 28 57 E Turkey, Asia Minor
Jakarta 6 08 S 106 45 E Indonesia, Asia; Capital

—— s,



Name Latitude  Longitude Country/Continent

Deg Min NS Deg Min EW
Jerusalem 31 47 N 35 13 E Israel, Middle East
Johannesburg 26 10 N 28 02 E SouthAlrica, Africa
Kabul 34 30 N 69 10 E Alghanistan, Asia; Capital
Karachi 24 51 N 67 02 E Pakistan, Asia
Khartoum 15 33 N 32 32 E Sudan, Alrica; Capital
Kiev 5 26 N 30 31 E USSR, Europe
Kinshasa 4 18 S 15 18 E Zaire, Alrica; Capital
Kyoto 35 02 N 135 45 E Japan, Asia
Lagos 6 27 N 3 28 E Nigena, Alrica; Capital
La Paz 16 30 S 68 10 W Bolivia, S. America; Capital
Leningrad 59 85 N 30 25 E USSR, Ewope
Lima 12 06 S 77 03 W Peru. S. Amernica; Capital
Lisbon 3B 4 N 9 08 W Portugal, Europe; Capital
London 51 30 N 0 10 W England, Europe; Capital
Longyearbyen 78 12 N 15 40 E Svalbard, Norway, Europe
Madrid 40 25 N 3 43 W Spain, Europe; Capital
Magadan 59 38 N 150 50 E USSR, Asia
Manila 14 37 N 120 58 E Phillipines; Capital
Marrakech 31 49 N 8 00 W Morocco, Alrica
Mecca 21 26 N 39 49 E Saudi Arabia, Middle East
Melbourne 37 45 S 144 58 E Victona, Australia
Montevideo 34 5 S 56 10 W Uruguay, S. America; Capital
Moscow 55 45 N 37 42 E USSR, Europe; Capital
Murmansk 68 59 N 33 08 E USSR, Europe
Nagasaki 32 45 N 129 52 E Japan, Asia
Nairobi 117 § 36 50 E Kenya, Aliica; Capital
New Delhi 28 37T N 77 13 E India, Asia, Capital
Novosibirsk 55 04 N 83 05 E USSR, Asia
Omsk 55 00 N 73 22 E USSR, Asia
Oslo 59 5 N 10 45 E Norway, Europe; Capital
Paris 48 52 N 2 20 E France, Europe; Capital
Peking 39 55 N 116 26 E China, Asia; Capital
Perth 31 58 S 115 49 E West Australia
Prague 50 06 N 14 26 E Crechoslovakia, Europe; Capital
Quito 0 14§ 78 30 W Ecuador, S. America; Capital
Rangoon 16 47 N 96 10 E Burma, Asia; Capital
Reykjavik 64 09 N 21 58 W Iceland; Capital
Riode Janeiro 22 53 § 43 17 W Brazl, S. America
Riyadh 24 39 N 46 46 E Saudi Arabia, Mdl. East; Capital
Rome 41 53 N 12 30 E Ialy, Europe; Capital
Saigon 10 46 N 106 43 E S. Vietnam, Asia; Capital
Santiago 33 30 S 70 40 W Chile, S. America; Capital
$ao Paulo 23 33 S 46 39 W Brazl, S. America
Seoul 37 30 N 127 00 E Korea, Asia; Capital
Shanghai 31 13 N 121 25 E China, Asia
Singapore 1 17 N 103 51 E Malacca, Asia
Sofia 42 40 N 23 18 E Bulgana, Europe; Capital
Stockholm 59 20 N 18 05 E Sweden, Europe; Capital
Sydney 33 55 S 151 10 E New South Wales, Australia
Taipei 25 05 N 121 32 E Taiwan, Asia; Capital
Tananarnive 18 52 S 47 30 E Madagascar, Capital

Tashkent 41 16 N 69 13 E USSR, Asia
Teheran 35 40 N 51 26 E Iran, Middle East; Capital
Tel Aviv 32 05 N 34 46 E Israel, Middle East
Thule 77 30 N 69 29 W Greenland
Timbuktu 16 49 N 2 59 E Mali, Alrica
Tokyo 35 40 N 139 45 E Japan, Asia; Capital
Tomsk 56 30 N 85 05 E USSR, Asia
Tripoli 32 5 N 13 12 E Libya, Aliica
Tunis 36 50 N 10 13 E Tunisia, Alrica; Capital
Vienna 48 13 N 16 20 E Austria, Europe; Capital
Vladivostok 43 09 N 131 53 E USSR, Asia
Warsaw 52 15 N 21 00 E Poland, Europe; Capital
Wellington A1 17 S 174 47 E  New Zealand; Capital
Yakulsk 62 10 N 129 %0 L USSH, Asia
Zanzibar 6 10 § 39 11 E Tanzama, Alrica
111 Islands

Name Lalitude Longilude Ocean

Deg Min NS Deg Min EW
Ascension 7 51 § 14 22 W Atlantic
Azores 38 30 N 28 00 W Atlantic
Bermuda 32 20 N 64 45 W Atlantic
Bouvel 54 26 S 3 24 E Atlantic
Canary 28 30 N 14 10 W Atlantic
Cape Verde 16 00 N 24 00 W Atlantic
Christmas 2 00 N 157 30 W Pacilic
Christmas 10 30 S 105 40 E Indian
Coco 13 14 N 144 39 E Pacilic
Cocos/Keeling 12 10 § 96 55 E Indian
Cook 20 00 S 158 00 W Pacilic
Easter 27 07 S 109 22 W Pacilic
Falkland 51 45 S 59 00 W Atlantic
Fiji 18 00 S 175 00 E Pacilic
Galapagos 0 3 S 90 30 W Pacilic
Gilbert 0 30 S 174 00 E Paclic
Gough 40 20 S 10 00 W Atlantic
Guam 13 50 N 144 75 E Pacilic
Jan Mayen 71 00 N 8 20 W Arctic
Kerguelen 49 15 S 69 10 E Antarclic
Marquesas 9 00 S 139 30 W Pacilic
Marshall 9 00 N 168 00 E Pacilic
Palmyra 5 5 N 162 05 W Pacilic
Pitcaim 25 04 S 130 06 W Pacilic
Samoa 14 00 S 171 00 W Pacilic
Seychelles 4 35 S 55 40 E Indian
SouthGeorgia 54 15 S 36 45 W Antarclic
South Orkney 60 35 S 45 30 W Antarclic
St. Helena 15. 57 S 5 42 W Atlantic
Tahiti 17 70 § 150 00 W Pacilic
Tonga 20 00 S 175 00 W Pacilic
TristandaCunha 37 15 S 12 30 W Atlantic
Wake 19 17 N 166 36 E Pacific




Names Stars & Navigational Stars

Name Declination Rl Asc. Conslellation Commenls Name Declination  RI. Asc. Conslellalion Commenls
Deg Min NS Hrs. Min. Deg Min NS Hrs. Min.

Acamar 40 18 S 2 58.3 Eridanus Merope 23 57 N 3463 Taus

Achemar 57 14 S 1 37.7 Eridanus Miaplacidus 69 43 S 9 13.2 Carina

Acrux 63 6 S 12 26.6 Crux Mira 25 S 2 19.3 Cetus “Disappearing™

Adhara 28 58 S 6 58.6 Canis Major star, varies

Albireo®) 27 58 N 19 30.7 Cygnus Blue/yellow during year

double star from very

Aldebaran 16 31 N 4 359 Tauws bright 10

Algenib 5 11 N 0132 Pegasus :;‘::‘;’:y?

Aigol 40:57° N '3 .82 Persaus m‘{ggf Mirfak 49 52 N 3243 Perseus

Alioth 56 58 N 12 540 UrsaMajor Nuats) SYL56 RN RT3 23.9 R Ursa Major gma;']:"

Alkaid 49 18 N 13 47.5 Ursa Major w/naked eye

Alnitam 112 5§ 5362 Orion Nunki 2 18 S 18 553 Sagillarius

Alphard 8 .40 S 9276 Hydm ) Peacock 5 44 S 20 256 Pavo

Alphecca 26 43 N 15 347 Corona Borealis Polaris 89 16 N 2 31.8 UrsaMinor Pole Star =

Alpheratz 29 5 N 0 8.4 Andromeda North Star

Altair 8 52 N 19 508 Aqila Polluxz 28 2 N 7 45.3 Gemini

Ankaa 42 18 S 0 26.3 Phoenix Procyon 5 14 N 7 39.3 Canis Minor

Anlares 26 26 S 16 29.4 Scorpio RasElhague 12 34 N 17 34.9 Ophiuchus

Arcturus 19 11 N 14 157 Booles Regulus 115 N 10 84 Leo

Atiia 69 2 S 16 48.7 Triangulum Auslrale Rigel 812 S 5 145 Orion

Avior 5 31 S 825 Caina Rigil Kentarus 60 50 S 14 39.6 Centaurus Third brightest

Bellatrix 6 21 N 5 25.1 Orion star: closest

Betelgeuse 724 N 5 55.2 QOrion star to Sun

Canopus 52 42 S 6 24.0 Carina Second (4.3 light

brightest star years)

Capella 45 60 N 5 167 Auiga Sabik 15 44 S 17 104 Ophiuchus

Caph 5 9 N 0 9.2 Cassiopeia Saiph 9 40 S 5 47.8 Orion

Castor 31 53 N 7 346 Gemini Schedar 56 32 N D 40.5 Cassiopeia

Deneb 45 17 N 20 41.4 Cygnus Shaula 37 06 S 17 33.6 Scorpio

Deneb Kaitos 17 59 S 0 436 Celus Sirius 16 43 S 6 45.1 Canis Major Brightest star

Denebola 14 34 N 11 490 Leo Spica 1110 § 13 253 Virgo

Dubhe A1 45 N 11 37 UrsaMajor Vega 38 47 N 18 369 Lya Orbiting infra-

Elnath 26 36 N 5263 Tawus ted observalory

Eltanin 5129 N 17 566 Draco recently

Enil 95 N 21 442 Pegasus discovered
€9 ) solar system

Fomalhaut 29 37 S 22 57.6 Pisces Austrinus in lormative

Gacrux 57. 7 'S 12 31.2 Crux state

Gienah 17 32 § 12 158 Covus Zuben Elgenubi 16 02 S 14 509 Libra

Hadar 60 22 S 14 38 Centaurus

Hamal 23 28 N 2 7.2 Aries *) 30-40 X telescope needed

Kaus Australis 34 23 S 18 24.2 Sagiltarius

Kochab 74 9 N 14 50.7 Ursa Minor **) In ancient times, the Arabs used the star Mizar in the Big Dipper for

Markab 15 12 N 23 48 Pegasus testing vision. If you could see two stars, your eyesight was perfect!

Menkar 4 5 N 3 23 Celus Mizar's companion star is Alcor.

Menkent 36 2 S 14 6.7 Centaurus




°
Constellations
* Constellations Belong to Zodiac
**Constellations Have Line Diagrams in Planetarium

t Marked Constellations Are Post-Ptolemy (c. 150 A.D.)

Abr.  Latin Name  English Name Commenls Abr.  Lalin Name  English Name Comments
And Andromeda Andromeda Great Spiral Galaxy (M31), most distant Lac  !lacerta Lizard

naked eye object (2 million light years) Leo **‘Leo Lion
Ant  fAntilia Air Pump Lep Lepus Hare
Aps  fApus Bird of Paradise Lib ***Libra Scales
Agl  **Aquila Eagle LMi  tLeo Minor Little Lion
Agr  *Aquarius Water Carrier Lup  Lupus Woll
Ara Ara Altar Lyn  ILynx Lynx
Ari *Aries Ram Lyr  *‘Lyra Lyre Vega (see star table), Ring Nebula (M57)
Aur  **Auriga Charioteer Men  IMensa Table Mountain
Boo **Bootes Herdsman Mic  tMicroscopium  Microscope
Cae  fCaelum Graving Tool Mon  tMonoceros Unicorn
Cam tCamelopardus  Giralle Mus  tMusca Fly
Cap ***Capricorn Sea Goat Nor  tNorma Level
Car 1Carina Keel Oct  10ctans Octant
Cas *‘Cassiopeia Cassiopeia Oph Ophiuchus Serpent Holder
Cen Centaurus Centaur Rigil Kentaurus - a-Centauni, this is the 0 **Orion Orion Great Nebula (M42)

closest star (4.3 light years) Pav  tPavo Peacock
Cep **Cepheus Cepheus Peg  **Pegasus Pegasus
Cet  Cetus Whale Per  **Perseus Perseus
Cha  tChamaeleon Chamaeleon Phe  tPhoenix Phoenix
Cir {Circinus Compass Pic 1Pictor Easel
CMa  Canis Major Big Dog PsA  Piscis Auslrinus  Southern fish
CMi Canis Minor Little Dog Psc  *Pisces Fishes
Cnc  °*Cancer Crab Beehive Cluster - Praesepe Cluster (M44) Pup  1Puppis Stem
Col tColumba Dove Pyx  1Pyxis Mariner's Compass
Com  1Coma Berenices Berenice's Hair Ret  tReticulum Net
CrA Corona Australis  Southem Crown Scl 1Sculptor Sculptor
CiB  **Corona Borealis  Norther Crown Sco  **1Scorpius Scorpion
Crt Crater Cup Sct 1Scutum Shield
Cru 1Crux Southem Cross Ser Serpens Caput  Serpent
Crv Corvus Crow Cutter's Mainsail Ser Serpens Cauda  Serpent
CVn  {Canis Venaciti  Hunting Dogs Sex  1Sextans Sexlant
Cyg **Cygnus Swan Northern Cross, CygX-1 may be Sye Sagitta Atlow

. “Black Hole™ Sgr  ***Sagiltarius Archer Tea Pot, Center of our galaxy (Milky Way)
Dl **Delphinus Dolphin Tau  *Taurus Bull Crab Nebula (M1) w/pulsar is remnant
Dor  1Dorado Goldfish of 1054 A.D. supemova, Hyades and
Dra Draco Dragon Pieiades Clusters
Equ Equuleus Little Horse Tel tTelescopium Telescope
Eri Eridanus River TrA  **tTnangulum
For  tFomax Fumace Auslrale Southem Triangle
Gem ***Gemini Twins Tii Triangulum Triangle
Gu  1Grus Crane Tuc  fTucana Toucan
Her  **Hercules Hercules Great Cluster (M13) UMa **Ursa Major Big Bear Big Dipper, Exploding galaxy (M82)
Hor  tHorologium Clock UMi  **Ursa Minor Little Bear Little Dipper, Polaris
Hya  Hyda Sea Serpent Vel tVela Sail
Hys °**1Hydrus Water Monster Vir *Virgo Virgin
Ind 1indus Indian Vol Volans Flying Fish
Vul  tVulpecula Little Fox




I:UTU RE Year Dale Duration (Min) Location
ASTRONOM I CAI_ EVENTS 1995 Oct. 24 24 S. Asia, Pacific and Indian Oceans
1997 Mar. 9 28 Siberia, Arclic
. 1998 Feb. 26 44 Central America, Pacific and Atlantic
Total Solar Eclipse Oceans
(WARNING — Never look directly al the SUN, even during a total eclipse) 1999 Aug. 11 26 . Central and Southem Europe, Central Asia
Year Dale  Duralion (Min) Location Transils by Venus Transils by Mercury*)
1984 Nov. 22 2.1 Indonesia, S. Ametica, Pacilic Ocean 2004 June 8 1985 Nov13
1987 Mar. 29 0.3 Equatorial Africa, Atlantic Ocean 2012 June 5-6 1993 Nov. 6
1988 Mar. 18 40 Phillipines, Indonesia, Indian and 1999 Nov. 15
Pacilic Oceans *) Telescope needed
1990 July 22 26 Finland, North Atlantic g
1991 July 11 7.1 Hawaii, Brazil, Central America, Pacilic Ha"ev $ come‘
Ocean Best time of observation, Northern Hemisphere: 1985, Seplt.-Dec.
1992 June 30 5.4 South Atlantic Perihelion: 1986, early February
1994 Nov. 3 4.6 S. America, Pacific Ocean Best time of observation, Southern Hemisphere: 1986, March-July
CONVERS'ONS Another unit of distance is the parsec. It is defined
. to be the distance at which the orbit of the earth
Distance has an apparent radius of 1 sec. of arc. Since the
Canied average radius of the earth’s orbit is 149,500,000 km,
velocily = distance this enormous distance is:
time
i : ; M9500.000km _______ _ 55936590 100 km
e.g. velocity of light = 186,282 miles = 299,793 km 1sec / 3600 sec/deg / 180 deg/pi * radians
=3.25943 light years
1second 1second

distance = velocity * time

e.g. light second
= 186,282 miles/sec * 1sec = 186,282 miles
299,793 km/sec * 1sec = 299,793 km

. light minute

186,282 miles/sec * 1 min * 60 sec/min
= 11,176,945 miles

299,793 km/sec * 1min * 60 sec/min
17,987,550 km

light hour

186,282 miles/sec * 1 hr * 60 min/hr * 60 sec/min
670,616,721 miles

299,793 km/sec * 1 hr * 60 min/hr * 60 sec/min
=1,079,253,000 km

e.g. light year
= 186,000 miles/sec * 1 * 365.25 * 24 * 60 * 60
= 5,878,626,175,000 miles
= 299,793 km/sec * 1* 365.25 * 24 * 60 * 60
=9,460,731,798,000 km

°
n e

°
won o

One light year is therefore 0.306802 parsecs.
Hours and Degrees
Hours <=—> Degrees
24 hrs =360 degrees
Hours ——Degrees
e.g. Convert 7 hrs 12 min 27 sec to degrees

7 hrs * 360 deg/24 hrs = 105.0000 deg
12 min * 1 hr/60 min * 360 deg/24 hrs = 3.0000 deg
27 sec * 1 hr/3600 sec * 360 deg/24 hrs = 0.1125 deg
108.1125 deg
i.e.
108.1125 degrees
Degrees— Hours

e.g. Convert 108.1125 deg to hrs:min:sec
108.1125 deg * 24 hr/360 deg = 7.2075 hrs

0.2075 hrs * 60 min/hr =12.450 min

0.450 min * 60 sec/min = 27.00 sec

or
7 hrs 12 min 27 sec




Asteroid:

Astronomy:

Autumnal Equinox:

Azimuth:

Cardinal Directions:

Celestial Equator:

Celestial Pole:

Celestial Sphere:

Chronologist:

GLOSSARY

A rocky object, smaller
than a planet, that orbits
the sun.

The branch of science
that studies the universe
beyond the Earth’s
atmosphere.

The equinox that takes
place around
September 23.

The position of an object
above the Earth. The
number of degrees east
from due north to the
object’s vertical circle.

North, south, east,

or west.

An imaginary circle on
the celestial sphere di-
rectly above the Earth’s
equator.

Either of the two
imaginary points on the
celestial sphere directly
above the Earth’s North
and South Poles.

An imaginary sphere
surrounding the Earth
and representing the
entire sky. The stars,
planets, and other
heavenly bodies appear
to be located on the
surface of the celestial
sphere.

A person who studies
time and records human
history. Orders the time
and place of events in the
order in which they
occurred.

Chronometer:

Circumpolar:

Cluster:

Comet:

Configuration:

Conjunction:

Constellation:

Declination:

Double Star:

Instrument used to
keep time with great
accuracy.

Surrounding or found in
the vicinity of the Earth’s
or the sky’s poles.

Groups of thousands to
millions of stars that
appear to be close
together.

A bright heavenly body
made up of ice, frozen
gases, and dust particles
that orbits the sun. It has
a long tail that points
away from the sun.

The arrangement of
several things.

The apparent meeting or
passing of two or more
celestial bodies in the
same degree of the
zodiac.

A group of stars forming
a pattern that suggests an
object, animal, or myth-
ological character. The
constellations divide the
sky into 88 areas.

The angular distance of a
celestial body north or
south of the celestial
equator.

Two stars that appear as
one because they are
nearly in line with each
other, or are close
together.




Eclipse:

Ecliptic:

Elevation:

Equatorial Sky

Orientation Map:

Equinox:

Extraterrestrial:

Galaxy:

Greenwich
Mean Time:

Total or partial blocking
of light from a celestial
body caused by its pass-
ing into the shadow of
another body. Also the
hiding of on a celestial
body by another.

The circular path that the
sun seems to travel in a
year around the sky.

The angular distance of a
celestial body above the
horizon.

Mercator projection of
the celestial sphere.

Either of the two times a
year when day and night
are of equal length all
over the Earth. During
these two times, the sun
is directly above the
equator.

Originating or existing
outside the Earth or its
atmosphere.

Any of the huge
grouping of stars, dust,
and gases scattered
throughout the universe.
Billions of stars held
together by gravitational
attraction.

The time at the prime
meridian in Greenwich,
England. Used as the
prime basis of standard
time by which the time
zones of the world are
established.

Horizon:

Latitude:

Light Year:

Longitude:

Lunar Eclipse:

Mathematician:

Meridian:

Messier Number:

The line where the sky
and the Earth, or sea,
meet.

The angular distance
north or south of the
equator. All points of a
given latitude form a
circle running east and
west. These circles are
parallel to the equator.

The distance travelled by
lightin one solar year.
About 5,880,000,000,000
miles.

The angular distance east
or west of the prime
meridian. All points of a
given longitude form a
circle running north and
south through the North
and South Poles.

A partial or total
darkening of the moon
when the Earth moves
between the moon and
the sun.

An expertin
mathematics.

Imaginary great circles
on the Earth’s surface
passing through the
North and South Poles.
Also known as longitude.

Charles Messier was a
French astronomer and
comet hunter who
prepared the first catalog
of non-stellar sky objects.
He assigned a number

to these objects as he
encountered them in his
comet hunting.




Meteor:

Meteorite:

Meteoroid:

Millennial:
Moon:

Nebula:

Opposition:

Orbital (positions):

Parallel:

Phases:

The streak of light caused
by a meteoroid that
passes through Earth’s
atmosphere. The
burning meteoroid is
often called a

“shooting star.”

A meteoroid that survives
passage through the
Earth’s atmosphere and
arrives on the Earth’s
surface without
completely burning up.

A solid body, smaller
than an asteroid, that
orbits the sun. Both
meteors and meteorites
were meteoroids.

Of or relating to a
thousand years.

A natural satellite
orbiting a planet.

A bright, cloudlike mass
composed of stars, or
dust, and gases. Visible
in the night sky.

A position that is oppo-
site to another.

Of or relating to the path
of a heavenly body as it
revolves in a closed curve
around another body.

Going in the same direc-
tion and always being the
same distance apart at
every point, so as never
to meet.

The varying shape of the
lighted position of a
planet or moon, such as
full, half, crescent, etc.

Planet:

Planetary
Occultations:

Planetary Transit:

Precession:

Prime Meridian:

Pulsars:

A rotating body held in
orbit by the gravitational
attraction of a star. A
planet is not self-
luminous; it reflects star-
light. Its own gravity
pulls the planetinto its
most stable shape, a
slightly flattened sphere.

The hiding of a star or
one planet by another
planet.

The passage of a planet
directly between the
earth and the sun so that
it can be seen as a black
dot moving across the
disk of the sun.

A slow change in the
direction of the tilt of
the Earth’s axis. This
results in an apparent
change in the position of
the stars. Precession is a
wobble in the rotation of
the Earth, like a top when
it slows down.

O° longitude which runs
through Greenwich,
England. The point from
which longitude east and
west is measured.

A neutron star that
rotates rapidly and emits
a beam of radiation. Any
number of astronomical
objects that send out
intense pulses of radiation
at short, regular intervals.




Refraction:

Right Ascension:

Rotation:

Sextant:

Slew:

Solar Day:

Solar Eclipse:

The change in the
apparent position of a
celestial body due to the
bending of the light rays
which come from the
celestial body.

The east/west coordinate
by which the position of
a celestial body is
measured.

The act or process of
turning around an axis.
The rotation of the Earth
takes 24 hours.

An instrument for deter-
mining the angle
between the horizon and
a celestial body. Used in
navigation of ships and
planes to determine
latitude.

To turn about a fixed
point.

The time interval
between 2 successive
transits by the sun of the
meridian directly oppo-
site that of the observer.
The 24 hour interval from
one midnight to the
following.

The partial or total
blocking of the sun’s
light by the moon as it
passes between the sun
and the Earth.

Solar Year:

Stellar:
Synchronize:

Trajectory:

Universe:

Vernal Equinox:

Zenith:

Zodiac:

Thetimeinterval between
one vernal equinox and
the next. 365 days, 5
hours, 48 minutes, and 46
seconds.

Resembling a star or
stars.

To happen at the same
time.

The path followed by a
meteor, or the like,
moving through space.

All that exists including
the Earth, heavens, and
all of space. The entire
physical world.

The equinox that takes
place around March 21.

The pointin the heavens
directly above the place
where a person stands.

An imaginary beltin the
heavens approximately
18° wide that the sun, the
moon, and all the planets
except Pluto appear to
follow. The zodiac is
divided into 12 parts,
called signs, with each
part named after a
constellation.
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SUPPLEMENTARY READING

H CODE
Books & Articles Astronautics/Xtraterr. Life
Code: E = Elementary Navigation
: : ;ngla;ed History/Archaeology
* = MultiAuthored Chronology/Calendars

Astronomy/Deep Sky Objects
Astronomy/General
Astronomy/Star Finding —I

Geography T

Anon = Anonymous Author

*, “Scientific Reports on Viking Missions (Mars),”
Science, Vol. 193, No. 4255, August 1976, pp. 759-815;
Vol. 194, No. 4260, October 1976, pp. 57-110;

Vol. 194, No. 4271, December 1976, pp. 1274-1353.

*, “Scientific Reports on Voyager Missions (Jupiter),”
Science, Vol. 204, No. 4396, June 1979, pp. 945-1008;
Vol. 206, No. 4421, November 1979, pp. 925-996.

Abell, George O., Exploration of the Universe, viivi|v

New York, Holt, Rinehart and Winston, 3rd Ed. 1975.

Abell, George O., The Search for Life Beyond Earth:
A Scientific Update, in James L. Christian: The First
Encounter, Buffalo, N.Y., Prometheus Books, 1976

Albers, Steven C., “Mutual Occultations Of Planets: v
1557 to 2230,” Sky and Telescope, March 1979, pp. 220-222.

Anon., Astronomy (Merit Badge Library #3303), Boy Scouts v
of America, Scout Equipment Center, 289 Park Avenue
South, New York City.

Anon., The Earth and Man, New York, Rand McNally v
& Company, 1972.

Anon., Space Exploration (Merit Badge Library #3354),
Boys Scouts of America, Scout Equipment Center,
289 Park Avenue South, New York City.

Anon., The Times Atlas of the World, Comprehensive v
Edition, New York, Quadrangle/The New York Times
Book Co., 5th Ed., 1975.

Ashbrook, Joseph, “Astronomical Scrapbook: Some v
Bunchings of Planets,” Sky and Telescope, November
1973, pp. 300 & 305.

Asimov, Isaac, Asimov on Astronomy, New York, v v

Doubleday, 1975.
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Navigation
History/Archaeology
Chronology/Calendars
Astronomy/Deep Sky Objects
Astronomy/General
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Asimov, Isaac, Exploring the Earth and the Cosmos, v v v
New York, Crown Publishers, 1982.

Banks, Arthur, A World Atlas of Military History, New York, v
Hippocrene Books Inc., 1973.

Barraclough, G. (Ed.), The Times Atlas of World History, v v
Maplewood, N.J., Hammond Inc., 1979.

Beatty, J. Kelly, Brian O’Leary, Andrew Chaikin (Ed.), v
The New Solar System, 2nd Ed., Cambridge,
Massachusetts, Cambridge Univ. Press.

Bergamini, David et al, The Universe, New York/Chicago, vV
Time Inc., 1962. (Life Nature Library)

Breed, Joseph B. Il1, Stars for the Space Age, New York, v
World Publishing/Times Mirror, 1971.

Calder, Nigel, The Comet is Coming, New York, Viking v
Press, 1980.

Clarke, Arthur C., The Exploration of Space, Revised Ed.,
1979.

Ernst, Br., T). E. De Vries, Atlas of the Universe, vIv|v
London/New York, Thomas Nelson and Sons Ltd., 1961.

Friedman, H., The Amazing Universe, Washington D.C., VI v|v
National Geographic Society, 1975.

Gardner, Martin, The Relativity Exploration: A Lucid vV
Account of Why Quasars, Pulsars, Black Holes & the
New Atomic Clocks Are Vindicating Einstein’s
Revolutionary Theory, Random, 1976.

Gingerich, Owen, “Astronomical Scrapbook: How v v
Astronomers Finally Captured Mercury,” Sky and
Telescope, September 1983, pp. 203-205.

Goell, Theresa, “Throne Above the Euphrates,” V|V
National Geographic, March 1961, pp. 381-405.

Gore, Rick, “The Once and Future Universe,” V|V
National Geographic, June 1983, pp. 704-749.
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Hart, M.R., How to Navigate Today, Cambridge, Maryland,
Cornell Maritime Press, 1970.

Hirschfeld, Alan, Roger Sinnott (Ed.), Catalogue v
2000.0, Vol. 1: Stars to Magnitude 8.0, Cambridge,
Mass., Cambridge Univ. Press, 1982.

Hughes, David, The Star of Bethlehem: An Astronomer’s v
Confirmation, Walker & Co., 1979.

Janiczek, P.M., L. Houchins, “Transits of Venus and the v
American Expedition of 1874, Sky and Telescope,
December 1974, pp. 366-371.

Krupp, E.C., Echoes of the Ancient Skies, New York, v
Harper & Row, 1983.

Lindsay, Jack, Origins of Astrology, New York, % v
Barnes & Noble, 1971.

Michener, James, Space (A Novel), New York,
Fawcett, 1983.

Moyer, G., “The Origin of the Julian Day System,” v
Sky and Telescope, April 1981, pp. 311-313.
Neugebauer, Otto, A History of Ancient Mathematical v
Astronomy,” Berlin, Springer, 1975. (3 Volumes)

Neugebauer, Otto, H.B. Van Hoesen, “Greek v
Horoscopes,” Memoirs of the American Philosophical
Society, Vol. 48, Philadelphia, 1959.

Newton, Robert R., Ancient Astronomical Observations v v
and the Accelerations of the Earth and Moon, Baltimore/
London, Johns Hopkins Press, 1970.

Norville, Warren, Celestial Navigations Step by Step,
New York, Association Press, 1973.
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